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Уважаемые 
читатели!

Европейский произво-
дитель полупроводников 
STMicroelectronics – один из 
самых ярких примеров грамот-
ной инновационной политики 
на рынке электронных компо-
нентов. Когда-то компания со-
единила в одно целое француз-
скую Thomson и итальянскую 
SGS. И та и другая возникли 
на огромном расстоянии от тра-
диционных мест разработки и 
производства полупроводников. 
И тогда ST стала создавать цен-
тры разработки по всей Цен-
тральной Европе, а также – в 
Северной Африке, привлекая 
местные «светлые головы» к раз-
работке. А для строительства в 
2002 году второй очереди цен-
тра разработок и крупного про-
изводства во французских Аль-
пах, в городке Кроль (Crolles) 
близ Гренобля, был создан вре-
менный альянс ST c тогдашними 
Philips и Motorola.

Philips и Motorola уже нет на 
рынке (теперь это NXP, On Semi 
и Freescale, соответственно), а 

компания STMicroelectronics за-
нимает пятое место в мировом 
рейтинге производителей полу-
проводников, сразу после Texas 
Instruments. У компании – 18000 
патентов, а на новые разработки 
и исследования она тратит бо-
лее двух миллиардов долларов в 
год. Для сравнения – на запуск 
инновационного центра в Скол-
ково под москвой планируется 
потратить четыре с половиной 
миллиарда. Но – рублей.

STMicroelectronics во многих 
случаях выступает как перво-
проходец технологии – доста-
точно вспомнить, что именно эта 
компания вывела на рынок пер-
вый 32-битный микроконтрол-
лер на ARM-ядре Cortex. Инно-
вации компания осуществляет во 
всех сегментах рынка электрон-
ных компонентов: от новых ви-
дов корпусирования до созда-
ния силовых мОп-транзисторов 
с уникальными характеристи-
ками и оригинального инстру-
ментария и средств разработки. 
В качестве яркого примера мож-
но привести мэмС-датчики. 
STMicroelectronics – производи-

тель номер один этой продукции 
в мире, и если бы на изделиях 
ставили знак «мэмС от ST – 
Inside», подобный маркировке 
«Intel Inside» на корпусах ком-
пьютеров, то многие с удивлени-
ем увидели бы её на культовой 
электронике нашего времени. 
В Apple’овском i-Phone функ-
цию датчика ускорения выпол-
няет акселерометр от STMicro. 
В игровой консоли Wii пульт 
управления построен на трехосе-
вом мэмС-гироскопе ST.

КОмпэл уже несколько 
лет сотрудничает с компани-
ей STMicroelectronics и готов 
ответить на все ваши запро-
сы по этой продукции. поэто-
му и на нашем офисе вы впол-
не можете представить табличку 
«STMicroelectronics Inside».

С уважением,
Геннадий Каневский

ОТ РЕДАКТОРА
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STMicroelectronics – компания, в линейку продукции которой входят 
как «рабочие лошадки», так и инновационные изделия, базирующиеся на са-
мых передовых технологиях сегодняшнего дня. Об этом и о своей уверенно-
сти в грядущем росте рынка рассказывает в интервью редактору «Новостей 
электроники» Геннадию Каневскому региональный вице-президент, дирек-
тор по продажам в Восточной Европе компании STMicroelectronics 
Бруно Котта.

мы сохраняем 
традиции инноваций и лидерства

Бруно Котта

Геннадий Каневский: Какие новей-
шие «звездные» продукты компании 
STMicroelectronics, по Вашему мне-
нию, подходят для российского рынка 
электроники?

Бруно Котта: Несомненно, в первую 
очередь нам бы хотелось отметить семей-
ства микроконтроллеров ST: 8-битные 
STM8 и 32-битные Cortex-M3 STM32 – 
оба семейства широкие, инновационные, 
развивающиеся, устойчивые, эффектив-
ные и рентабельные. Поддерживаемые 
всеми лидирующими поставщиками ин-
струментария, эти две линейки охваты-
вают большинство потенциальных при-
менений наших клиентов, позволяя им 
реализовывать эффективные рентабель-
ные проекты с минимальным сроком 
выхода на рынок.

Ведущий производитель аналоговых 
и силовых полупроводников, компания 
STMicroelectronics сохраняет свои тра-
диции новаторства и лидерства, пред-
лагая широкий ассортимент устройств 
от датчиков до мощных ИС, дополнен-
ных большой линейкой мощных дис-
кретных компонентов. Наши продук-
ты предоставляют каждому инженеру 
первоклассный выбор, который помо-
жет оптимизировать КПД и уменьшить 
затраты на разработку. Мы бы посове-
товали всем клиентам ST обратить вни-
мание на нашу продукцию из серии 
«Мир аналога», включающую датчики 
и MEMS, усилители, интерфейсы, ана-
логовые сигнальные и преобразователь-
ные микросхемы, а также устройства 
управления питанием и многое другое.

Использующая разнообразные тех-
нологии в области производства крем-
ниевых пластин и корпусирования из-
делий (многие из них запатентованы) 
линейка ASSP (изделий специализиро-
ванного применения) от ST, предназна-
ченная для промышленных применений, 

включает большой список проектных 
решений для многих индустриальных 
систем: от освещения до устройств 
управления электроприводом, робото-
техники, автоматизации производства 
и автоматизированных систем учета и 
контроля энергоресурсов. Первой пред-
ставив комбинированные аналоговые/
цифровые/силовые технологии изго-
товления полупроводников (например, 
хорошо известную BCD – Биполярную-
КМОП-ДМОП), ST продолжает раз-
рабатывать новые ASSP, позволяющее 
создавать высокоэнергоэффективные 
системы с минимальной занимаемой на 
плате площадью.

Также мы предлагаем широкую ли-
нейку технологий и ИС для промыш-
ленных применений, включающих про-
мышленную и бытовую автоматизацию, 
системы учета энергоресурсов, решения 
для управления электроприводом и осве-
щения, в том числе – драйверы свето-
диодов. Полупроводники для устройств 
управления питанием являются сердцем 
сверхэффективных систем. ST предла-
гает крупнейшую в мире номенклатуру 
устройств, способствующих энергосбе-
режению, большей удельной плотности 
мощности и меньшему потреблению в 
режиме ожидания. Производимая на 
основе нашего богатого опыта в произ-
водстве ИС управления питанием и в 
разработке технологий интеллектуаль-
ного управления питанием продукция 
компании ST включает высокоинтегри-
рованные преобразователи напряжения 
линейного и переключающего типов, си-
ловые ключи и драйверы.

Г.К.: Что отличает новые семейства 
микроконтроллеров STM32 и STM8 от 
решений, предлагаемых конкурента-
ми?

Б.К.: STMicroelectronics предлага-
ет широкую линейку мощных 8-битных 

микроконтроллеров и высокоэффектив-
ных 32-битных микроконтроллеров на 
ARM-ядре с широким ассортиментом 
периферийных устройств. Расширенная 
поддержка благодаря сочетанию гибких 
и мощных инструментальных средств 
разработки, обучающих курсов, кон-
сультаций и web-поддержки способству-
ют уменьшению времени выхода гото-
вой продукции на рынок.

STMicroelectronics представляет но-
вую 8-битную платформу, разработан-
ную для того, чтобы достичь высоко-
го значения КПД и рентабельности в 
широком диапазоне применений. Реа-
лизованная на 8-битного ядре и сово-
купности современных периферийных 
устройств, платформа STM8 произво-
дится с использованием запатентован-
ной ST 130 нм технологии встроенной 
энергонезависимой памяти.

Семейство STM32 32-битных флэш-
микроконтроллеров основано на техни-
ческом усовершенствовании ядра ARM 
Cortex™-M3, специально разработанно-
го для встроенных применений. Преи-
мущества семейства STM32 основаны на 
использовании усовершенствования ар-
хитектуры Cortex-3M. Теперь она вклю-
чает набор команд Thumb-2, позволяю-
щих сочетать увеличение КПД с лучшей 
плотностью кода, добиться значительно 
более быстрого отклика на прерывания 
в сочетании с лучшим в отрасли энерго-
потреблением.

Семейство STM32 – это новая сте-
пень свободы для пользователей микро-
контроллеров. Оно предлагает полную 
32-битную продуктовую линейку, ко-
торая сочетает в себе высокий КПД, 
реальное время, работу на низкой и 
высокой мощности, одновременно под-
держивая полную интеграцию и просто-
ту разработки. Совместимость выводов, 
периферии и ПО для всех устройств 
STM32 является основной технической 
характеристикой микроконтроллеров 
этого семейства.

ST расширяет свою широкую номен-
клатуру микроконтроллеров для авто-
мобильной электроники с 8 бит до 32 
бит, запустив в производство STM8A и 
STM56, соответственно. Эти две новые 
платформы позволяют охватить все ав-
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томобильные применения: от экономич-
ных до очень сложных.

Г.К.: В чем, по Вашему мнению, 
заключаются особенности российско-
го рынка электронных компонентов, и 
как STMicroelectronics смогла приспо-
собиться к ним? Как ST планирует раз-
вивать отношения с Россией и страна-
ми СНГ?

Б.К.: Мы считаем, что рынок СНГ 
продолжит свое развитие, поэтому мы 
укрепляем наши позиции там, что-
бы иметь возможность предлагать бо-
лее масштабную поддержку, в особен-

ности – техническую. Кроме того, мы 
запустили серьезную программу подго-
товки по нашим продуктам и их при-
менениям для инженеров технической 
поддержки наших дистрибьюторов для 
того, чтобы десятки инженеров продви-
гали на рынке наши основные устрой-
ства.

Г.К.: Каков Ваш прогноз относи-
тельно состояния российского рынка?

Б.К.: Российский рынок определен-
но вырастет, у него есть огромный по-
тенциал, который рано или поздно бу-
дет реализован, и инвестиции окупятся.

Г.К.: Что бы Вы хотели пожелать 
российским разработчикам электрон-
ной техники?

Б.К.: Нам бы хотелось иметь воз-
можность встретиться с каждым и позво-
лить им испытать преимущества наших 
продуктов. Чтобы достигнуть этого, мы 
укрепляем нашу локальную сеть и уста-
навливаем все более тесные партнерские 
отношения с нашими дистрибьюторами, 
включая специализированное обучение.

Помимо этого, мы планируем открыть 
Интернет-сайт STMicroelectronics на рус-
ском языке. Это моя давняя мечта.

Производственный корпус STMicroelectronics в г. Катания, сицилия
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8-бит МК (ST6, ST7, UPSD, STM8) • • • • • • • • • • • • •
16-бит МК (ST10) • • • • • • •
32-бит МК (ARM7, ARM9, Cortex М3) • • • • • • • • • • • •
32-бит МК Power PC Architecture • • • • • •
Микросxемы памяти (EEPROM) • • • • • • • • • • • • •
NVRAM, часы реального времени • • • • • • • • • • •
BT, ZigBee, GPS-чипы и модули • • • • • • • •
Акселерометры • • • • • • • •
Датчики сенсорной 
клавиатуры • • • • • • • •
Датчики (температуры, зазора) • • • • • • • •
Мощные RF-транзисторы  • • • •
Полевые МОП, биполярные 
и IGBT-транзисторы • • • • • • • • • • • •
Микросxемы защиты • • • • • • • • • • • •
Силовые компоненты

AC/DC-преобразователи • • • • • • • • •
Модули источников питания • • •
DC/DC-преобразователи • • • • • • • • • • • •
Линейные регуляторы • • • • • • • • • • • • •
Источники опорного напряжения • • • • • • • • •
Интеллектуапьные силовые ключи • • • • • •
MOSFET/IGBT-драйверы • • • • • • • •
Диоды • • • • • • • • • • •
Интерфейсы • • • • • • • • • • •
Логика, коммутаторы • • • • • • • • • • •
Тиристоры, AC-коммутаторы • • • • •
Фильтры радиопомеx • • • • • • • • •
Усилители, линейные компоненты • • • • • • • • • • •
Смарткарты • • • • • •
Специализированные микросxемы • • • • • • • • • •

Продукция STMicroelectronics

Функциональная группа
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Э
та линейка по многим параме-
трам сравнима с 8-битными ми-
кроконтроллерами компаний 
ATMEL и Microchip, и впол-

не может их заменить. Но вдобавок она 
имеет ряд уникальных преимуществ, ко-
торые отличают ее от других решений:

1) Повышенная надежность. Это – 
наиболее ощутимое отличие семейства 
микроконтроллеров STM8. Достаточно 
сравнить технические руководства раз-
ных производителей, чтобы убедиться в 
этом: например, в руководстве по микро-
контроллерам STM8 есть раздел, посвя-
щенный EMC- и ESD-характеристикам 
микроконтроллера. В описании других 
микроконтроллеров такой раздел зача-
стую просто отсутствует.

Высокая надежность микроконтролле-
ров STM8 проявляется во многих аспек-
тах и является результатом долголетнего 
опыта STMicroelectronics в области про-
изводства микроконтроллеров для ин-
дустриальных и автомобильных приме-
нений. При разработке линейки STM8 
STMicroelectronics по максимуму учла все 
возможные улучшения по надежности.

Например, микроконтроллеры STM8 
выдерживают электростатический им-
пульс до 4 кВ (HBM) в отличие от конку-
рентных решений, где это значение – на 
уровне 1 кВ. Устойчивость к электро-
статическим импульсам позволяет не ис-
пользовать внешних защит и избежать 
дополнительных, часто очень сложных, 
проблем, связанных с этим вопросом. 
Микроконтроллеры STM8 имеют высо-
кую устойчивость к электромагнитным 
помехам (по стандартам IEC 61000, 2 В 
по VFESD, 4 A по VEFTB для STM8S) 
и низкий излучаемый электромагнитный 
шум (по стандарту IEC61967-2, уровень 
SAE EMI = 2). Вдобавок, микрокон-
троллеры STM8 имеют дополнительную 

возможность снизить генерируемые по-
мехи благодаря специальному режиму 
работы входов-выходов с пониженной 
скоростью (менее резкие фронты).

Разные режимы работы микрокон-
троллеров управляются специальны-
ми регистрами в памяти (option byte 
registers). Микроконтроллеры STM8 
имеют специальную схему работы ре-
гистра, контролирующего их конфи-
гурацию: идет постоянная аппаратная 
проверка состояния данного регистра 
(сумма его значения с противополож-
ным значением должна всегда быть ну-
левой). При обнаружении изменения в 
значении этого ключевого регистра (на-
пример, из-за жестких электромагнит-
ных условий) сразу происходит сброс 
МК. Наличие двух независимых сторо-
жевых таймеров, работающих от двух 
различных источников частоты тактиро-
вания, позволяет повысить надежность 
МК в жестких условиях.

Стоит отметить также, что в изделия 
семейства STM8 включена схема безо-
пасного тактирования (Clock Security 
System), которая переключает микро-
контроллер на внутренний генератор ча-
стоты тактирования (16 МГц) при обна-
ружении сбоя во внешнем генераторе.

2) Гибкость работы. Другая замеча-
тельная особенность семейства STM8 – 
гибкость во многих рабочих ситуациях. 
Например, вышеупомянутые регистры 
конфигурации запуска микроконтрол-
лера часто программируется с помощью 
памяти OTP. Это означает, что после их 
программирования режим работы ми-
кроконтроллера нельзя больше менять. 
Но в случае микроконтроллеров STM8 
этот регистр программируется во флэш-
памяти и его содержимое меняется. До-
ступ к памяти защищен так же, как в 
конкурентных решениях. Но еще одно 

важное отличие STM8 – единое адрес-
ное пространство памяти для ОЗУ и для 
флэш-памяти, размером до 16 МБ. Это 
увеличивает гибкость работы в сравнении 
с конкурентными решениями, особенно 
в случае применений, где программный 
код большой (128 кБ). У STM8 также 
имеются два высокоточных встроенных 
тактовых генератора частоты. Напри-
мер, для STM8S частота высокочастот-
ного генератора составляет 16 МГц, а 
низкочастотного 128 кГц, и, как след-
ствие, для большинства приложений нет 
необходимости во внешнем кварцевом 
генераторе. Наконец, в отличие от не-
которых конкурентов, миграция внутри 
семейства STM8 очень проста, и совме-
стимость входов-выходов сохраняется по 
максимуму (те же самые сигналы с той 
же самой стороны печатной платы). Пе-
реход с STM8 на STM32 также упрощен 
благодаря наличию общей периферии и 
библиотек этой периферии.

3) Стабильность параметров. Ми-
кроконтроллеры STM8 отличаются от 
конкурентных решений также и своей 
стабильностью: их характеристики мало 
меняются при изменении напряжения 
питания или рабочей температуры. Это 
связано с тем, что ядро и периферия ми-
кроконтроллера работают на напряже-
нии 1,8 В (благодаря новой технологии 
130 нм). Например, скорость преобра-
зования АЦП для STM8S гарантирован-
но составляет 2,3 мкс и не ухудшается 
при колебаниях температуры и напря-
жения. Точность частоты тактирования 
встроенного высокочастотного генера-
тора, которая калибруется на заводе до 
±2% (при 5 В/16 МГц – до ±1% при до-
полнительной программной калибровке 
пользователя), имеет разброс ±5% для 
температурного диапазона -40...150°С и 
напряжении 3...5,5 В. 

Такая точность и стабильность по-
зволяет работать с модулем UART для 
передачи данных, применяя внутренний 
тактовый генератор (16 МГц).

4) Расширенные параметры. Ми-
кроконтроллеры STM8 имеют по мно-
гим параметрам расширенные характе-
ристики. Например, EEPROM память 
можно программировать и стирать до 
300к циклов вместо обычных 100к. 

В России 8-битные микроконтроллеры ассоциируются в основном с про-
дукцией компании ATMEL (ATtiny, AVR)  и в меньшей степени – с продукци-
ей компании Microchip (PIC18F). Многие разработчики, уже хорошо знакомые 
с этими микроконтроллерами, не видят никакого смысла работы с другими 
8-битными изделиями. Но тем, кому еще предстоит сделать выбор, и тем, у 
кого возникли проблемы, стоит рассмотреть новую линейку микроконтролле-
ров STM8 компании STMicroelectronics.

Восемь 
преимущестВ STM8

Джафер Меджахед (КОМПЭЛ)
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Также встроенная память ОЗУ дости-
гает размера 6 кБ. Диапазон рабочей 
температуры тоже расширен до 125°С 
для тех индустриальных применений, 
где это требуется. Точность и скорость 
АЦП увеличены: у STM8S, 10-битный 
АЦП работает со скоростью 2,3 мкс, а у 
STM8L, 12-битный, 24-канальный АЦП 
работает со скоростью 1 мкс.

5) Соотношение цена/функциональ-
ность: STMicroelectronics – не просто ми-
ровой лидер в области микроконтролле-
ров, это и лидер по КМОП-технологиям 
со встроенной флэш-памятью, на осно-
ве которых производится большинство 
микроконтроллеров. Линейка STM8 
производится на современной КМОП 
технологии 130 нм со встроенной флэш-
памятью, в отличие от многих конкурен-
тов, которые используют более старые 
технологии. Это позволило снизить себе-
стоимость микроконтроллера, и в итоге, 
представить более дешевые решения с 
улучшенной функциональностью. Мно-
гие инновационные технологии исходят 
из европейских центров исследований 
и разработок компании ST – Crolles и 
Crolles II (Франция).

6) Производительность: ядро STM8 
является собственной разработкой 
STMicroelectronics и отличается высокой 
производительностью (выше или рав-
на значениям конкурентов). У STM8S 
производительность составляет 20 MIPS 
при 24 МГц, а у STM8L – 16 MIPS при 

16 МГц. Такая высокая производитель-
ность связана с тем, что большинство 
инструкций микроконтроллера выполня-
ются в одном цикле тактирования. Ядро 
STM8 также включает в себя аппаратные 
операции умножения и деления и ариф-
метические операции со знаком.

7) Доступная среда: для нача-
ла работы с микроконтроллерами 
STM8 можно купить отладочный на-
бор STM8S-Discovery менее чем за 15 
долларов и скачать бесплатную среду 
разработки STVD и STVP и бесплат-
ный C-компилятор (до 32 кбайт кода). 
Данный набор программно-аппаратных 
средств позволит довольно просто и бы-
стро начать работу с STM8S. Вдобавок 
стоит заметить, что STMicroelectronics 
предоставляет многие библиотеки для 
микроконтроллеров STM8 бесплатно, 
например, библиотеки сенсорных кла-
виатур, библиотеку для работы с пери-
ферией микроконтроллера, для управ-
ления двигателями.

8) Перспективная платформа: 
STMicroelectronics активно развивает и 
поддерживает линейку STМ8, и номен-
клатура микроконтроллеров постоян-
но обновляется и растет. Например, в 
ближайшее время линейка STM8 будет 
включать в себя варианты в корпусе SO 
(TSSOP и LQFP уже доступны). Встроен-
ный USB-интерфейс с большой вероятно-
стью тоже добавится в список периферии 
микроконтроллеров STM8. Возможный 

переход на технологию 90 нм со встроен-
ной флэш-памятью также откроет новые 
горизонты ценовых предложений.

В заключение можно сказать, что по-
вышенная надежность позволяет успеш-
но проходить сертификации и снижать 
до минимума количество брака. Гибкость 
решений и высокая производительность 
позволяет оснащать большой спектр из-
делий одним семейством микроконтролле-
ров STM8, а когда этого недостаточно по 
тем или иным причинам, переход на бо-
лее производительное и мощное семейство 
STM32 осуществляется с минимальными 
затратами. Стабильность параметров МК 
STM8 и его расширенные параметры зна-
чительно упрощают работу разработчиков 
и сокращают сроки разработки. В случае 
больших партий, благодаря хорошему со-
отношению цена/функциональность се-
мейства STM8, производитель значитель-
но уменьшает свои расходы на BOМ (Bill 
of Material). Дешевый инструментарий и 
бесплатные среды разработки позволя-
ют работать с этими микроконтроллера-
ми без значительных финансовых затрат. 
В статье рассмотрена только часть преи-
муществ микроконтроллеров STM8, для 
более подробного ознакомления со всеми 
их свойствами следует обратиться к до-
кументации.

Вид на центр исследований и разработок новых технологий Crolles I и сrolles II в г. Гренобле, Франция
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Л
инейка микроконтроллеров 
STM8 заменила STR7 в 2008 
году. На сегодня она состоит 
из трех семейств: для автомо-

бильного, низкопотребляющего и обще-
го применений. Это, соответственно, 
STM8A, STM8L и STM8S. Общая же 
номенклатура составляет более 160 по-
зиций, и компания постоянно работает 
над расширением каждой линейки. Хотя 
на рынке наметилась тенденция перехо-
да на 16/32-битные микроконтроллеры, 
8-битные все еще составляют основную 
часть рынка, и в ближайшее десятиле-
тие их доля останется значительной.

Инструментарий для работы
Для работы с любым микроконтрол-

лером, и STM8 – в частности, нам по-
надобятся отладочный комплект и сре-
да разработки c Си–инструментарием. 
В качестве отладочного комплекта мож-
но использовать любой из предоставля-
емых комплектов как от ST, так и от 
сторонних производителей. Рассмотрим 
STM8S-Discovery, его внешний вид 
представлен на рис. 1.

Данный выбор обусловлен, в первую 
очередь, очень низкой стоимостью ком-
плекта (меньше $15), его доступностью 
и дальнейшей пригодностью. Комплект 
состоит из двух частей. Одна – это кон-
троллер STM8S105С6 со светодиодом, 
сенсорной кнопкой и разъемами, на ко-
торые выведены все свободные порты 
ввода/вывода. Вторая – программатор-
отладчик ST-Link c USB-интерфейсом. 
Если внимательно посмотреть на изобра-
жение отладочного комплекта, то можно 
увидеть, что с помощью небольших уси-
лий его можно разделить на две части, и 
в дальнейшем использовать отделенный 
ST-Link для программирования и отлад-
ки своих собственных разработок. Всю 
необходимую документацию вы можете 
посмотреть и скачать по ссылке http://

www.st.com/mcu/contentid-130-
113-STM8S_DISCOVERY.html.

Выбор программного инструментария 
для разработки

На данный момент для разработки 
и отладки программного обеспечения 
для STM8 существует четыре среды: ST 
Toolset от STMicroelectronics (www.
st.com), Ride7 от Raisonance (www.
raisonance.com), CXSTM8 от Cosmic 
software (www.cosmicsoftware.com), 
IAR Embedded Workbench от IAR 
Systems (www.iar.com). Сравнитель-
ный анализ средств разработки про-
граммного обеспечения представлен в 
таблице 1.

Пакет ST Toolset включает в себя 
среду разработки ST Visual Develop и 
отдельную программу для более функ-
ционального внутрисхемного програм-
мирования flash-памяти микроконтрол-
леров ST Visual Programmer. Среда 
разработки ST Visual Develop имеет 
встроенный инструментарий для раз-

работки программного обеспечения на 
языке assembler, но у нее также имеется 
возможность подключения и использо-
вания Си-инструментария от Raisonance 
и Cosmic software. Стоит заметить, что 
все четыре среды с Си-инструментарием 
предоставляют возможность исполь-
зования с некоторыми ограничения-
ми, а именно – по загружаемому коду 
во flash-память. У Raisonance оно со-
ставляет 16 Кбайт, у Cosmic software – 
32 Кбайт, а у IAR – 8 Кбайт или 
полную версию с 30-дневным ограниче-
нием. Самый дешевый и оптимальный 
вариант – это использование ST Visual 
Develop в качестве среды разработки и 
Си-инструментария либо от Raisonance, 
либо от Cosmic software. Вы, конечно 
же, можете заметить, что наиболее из-
вестным и популярным является ин-
струментарий от IAR System, и тут с 
вами трудно не согласиться. Он пред-
ставляет собой более серьезный продукт 
с лучшей технической поддержкой, но 
и является самым дорогим. Итак, мы 
останавливаем свой выбор на ST Visual 
Developer, плюс Си-инструментарий от 
Cosmiс software и Raisonance. Боль-
шой разницы в использовании обоих 
инструментариев нет, и далее в своих 
разработках вы можете остановиться на 
любом из них. Если вы – начинающий 

В статье подробно рассказывается о том, как начать работать с микро-
контроллерами STM8 компании STMicroelectronics. Мы рассмотрим среды 
разработки, разберемся, как настроить проект для работы, коснемся некото-
рых особенностей линковки библиотек к проекту, и, в конце концов, совместно 
разберем небольшой рабочий проект для закрепления полученных знаний.

Микроконтроллеры 
STM8 «с нуля»

Роман Попов (КОМПЭЛ)

Рис. 1. STM8S-Discovery
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разработчик, и у вас недостаточный опыт, рекомендую уста-
навливать все программное обеспечение по предполагаемым 
установщиком местам расположения, т.е. по умолчанию. Это 
необходимо для меньшей путаницы при дальнейшей настрой-
ке проектов, расположении файлов, библиотек и синхрони-
зации с информацией приведенных материалов.

Установка программного инструментария для разработки
Итак, скачиваем и устанавливаем ST Toolset по ссыл-

ке http://www.st.com/stonline/products/support/
micro/files/sttoolset.exe. Далее нам необходимо скачать 
Си-инструментарий от Raisonance и от Cosmic software.

Открываем браузер, входим по ссылке http://
www.mcu-raisonance.com/microcontrollers-link-free-
download.html, скачиваем два установочных файла – это 
среда разработки Ride7 и инструментарий RKit-STM8. Уста-
навливаем в той же последовательности. После установ-
ки, необходимо получить бесплатную лицензию на исполь-
зование Си-инструментария, заполнив регистрационную 
форму http://www.mcu-raisonance.com/stm8_st7_
registration.html. В течение короткого срока вы получите 
лицензионный ключ по указанной в регистрации электронной 
почте. Запускаем среду «Пуск → Программы → Raisonance 
Tools → Ride7 → Ride7» и переходим на «Help → License». 
Вводим общую информацию, выбираем «Manual Activation», 
копируем ключ из поля «This computer Serial Key» в поле 
«Serial Key», вводим ключ, присланный по электронной по-
чте в поле «Paste the Activation code and Select Next» и, если 
все сделано верно, Си-инструментарий будет активирован и 
выдаст соответствующее сообщение.

Для установки Си-инструментария от Cosmic Software пе-
реходим по ссылке http://www.cosmicsoftware.com/
download.php и скачиваем инструментарий «STM8 32k free 
tools 2010 special edition», предварительно заполнив регистра-
ционные данные. Далее устанавливаем инструментарий, отправ-
ляем информацию, выданную при его установке, на электрон-
ную почту «stm8_32k@cosmic.fr». Спустя некоторое время вам 
придет ответное письмо с файлом лицензии. Теперь вы може-
те активировать Си-инструментарий, запустив среду разработ-
ки «Пуск → Программы → Cosmic Tools → STM8 32K Compiler 
4.3.4 → CXSTM8», которая предложит вам активировать про-
дукт двумя методами. Мы выбираем «Specify the License File» и 
указываем файл с лицензией.

На сайте STMicroelectronics вы можете найти всю необ-
ходимую информацию для работы c STM8S (http://www.
st.com/mcu/familiesdocs-113.html). На основе одного 
из примеров мы рассмотрим проект, более подробно оста-
навливаясь на ключевых моментах. Также мы остановимся 
на двух библиотеках – сенсорной и библиотеке стандартной 
периферии микроконтроллера – написанных инженерами 
STMicroelectronics для быстрого освоения всех линеек МК 
и вывода продукции на рынок. Вы можете отказаться от ис-
пользования библиотек и работать напрямую с именами реги-
стров или написать собственное программное обеспечение для 
работы с периферией микроконтроллера.

Обзор библиотек
Библиотека стандартной периферии содержит набор функ-

ций, структур данных и макросов, охватывающих свойства 
периферии микроконтроллеров STM8S. Использование би-
блиотеки в значительной степени облегчает процесс разработ-
ки собственного программного обеспечения, т.к. устраняется 
необходимость изучения документации с именами регистров 
и их функционального назначения. Последняя версия библи-
отеки со всей необходимой информацией доступна по ссылке 
http://www.st.com/mcu/familiesdocs-113.html, раздел 
«firmware». Структура библиотеки представлена на рис. 2.

Заголовочный файл «stm8s.h» содержит определения 
констант и структур регистров для всей периферии. Для ис-

Таблица 1. сравнительный анализ средств разработки программного обеспечения

Инструментарий Среда разработки Си-инструментарий
Си-инструментарий 
других производите-

лей

Ограничение Си-
иструментария, 

Кбайт

Программатор-
отладчик

STMicroelectronics ST Visual Develop Нет
Cosmic software,

Raisonance
Нет

ST-Link
R-Link
STICE

Raisonance Ride 7 Есть Нет 16 R-Link

Cosmic software CXSTM8 Есть Нет 32 Нет

IAR Systems IAR Workbench Есть Нет
8 или полная версия 

на 30 дней
ST-Link
STICE

Рис. 2. структура библиотеки стандартной периферии

Рис. 3. структура сенсорной библиотеки
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пользования библиотеки данный файл необходимо включить 
(«#include “stm8s.h”») в основной листинг программы 
«main.c», и раскомментировать строку («#define USE _
STDPERIPH _ DRIVER»). Функционал каждого периферийно-
го модуля состоит из заголовочного и исполняемого файла, 
например, для GPIO – это «stm8s _ gpio.h» и «sym8s _
gpio.с». В заголовочном файле описаны все переменные, 
константы, структуры данных и функции, обеспечивающие 
полный функционал конкретного периферийного модуля. 
В исполняемом файле осуществляется реализация функцио-
нала, описанного в заголовочном файле.

В заголовочном файле «stm8s _ type.h» стандартные 
типы переменных стандарта ANSI C переопределены в более 
короткие и понятные имена типов. В конечном счете вы мо-
жете скорректировать данный файл под наиболее понятные и 
удобные для вас имена типов.

Заголовочный файл «stm8s _ conf.h» используется для 
конфигурирования библиотеки необходимых для работы пе-
риферийных модулей, задания определенных констант (на-
пример, тактовой частоты работы ядра). Это осуществляется 
через раскомментирование макроопределений, соответству-
ющих определенному периферийному модулю, например, в 
приведенном ниже листинге расскомментированы вторая и 
четвертая строки:

1. /********* CLK *******/
2. #define _ CLK (1)
3. /********* EXTI **********/
4. #define _ EXTI (1)
5. /**** FLASH/DATA EEPROM ****/
6. /**** #define _ FLASH (1) ****/
7. /**** OPTION BYTES *****/
8. /**** #define _ OPT (1) ****/.

В связи с наличием разной периферии в файле «stm8s_
conf.h» учтены особенности периферийных модулей для 
определенного микроконтроллера. Например, в нижеприве-
денном листинге таймер 3 определен только в микроконтрол-
лерах STM8S208, STM8S207 и STM8S105:

1. /****** TIM3 ******/;
2. #if defined(STM8S208) || defined(STM8S207) ||
   defined(STM8S105);
3. /**** #define _ TIM3 (1) ****/;
4. #endif /**** (STM8S208) || (STM8S207) ||
   (STM8S105) ****/.

Работа с библиотекой и ее использование на конкретном 
примере будут рассмотрены ниже в разделе «Создание но-
вого проекта, конфигурирование библиотек». Более подроб-
ную информацию, файл справки «stm8s_fwlib_um.chm» вы 
можете посмотреть либо по ссылке http://www.st.com/
mcu/familiesdocs-113.html, либо в директории «STM8S_
StdPeriph_Driver» загруженного пакета программного обе-
спечения.

При использовании прерываний необходимо быть вни-
мательным, так как обработка источников прерывания раз-
лична для обоих инструментариев. Для инструментария от 
Raisonance используется функция без параметров (void) с 
префиксом «interrupt» и номера прерывания, например:

void timerA _ handler(void)
interrupt 8
{
// Код обработки прерывания
}
void top _ level _ interrupt _ handler(void) 
interrupt 0
{

// Код обработки прерывания
}.

Для инструментария от Cosmic все «пустые» обработчики 
прерывания описаны в файле «stm8s _ it.c», и весь код по 
обработке прерывания следует размещать здесь. Таблица век-
торов прерывания располагается в «stm8s _ interrupt _
vector.c», который связан с документом «stm8s _ it.c» 
через заголовочный файл. Для более подробного ознакомле-
ния с обработкой прерываний и особенностями компилято-
ра необходимо посмотреть документацию соответствующего 
компилятора.

Сенсорная библиотека разработана инженерами 
STMicroelectronics для применения в микроконтроллерах 
STM8, так как в настоящее время популярность и актуаль-
ность использования решений на основе сенсоров очень ве-
лика. Библиотека представляет собой набор совместимых 
С-файлов, включающих API, который образует интерфейс 
для работы с другими уровнями программного обеспечения. 
У компании STMicroelectronics существуют разнообразные 
решения в данной области, более подробную информацию вы 
можете получить на сайте компании. Структура библиотеки 
представлена на рис. 3.

Для использования библиотеки в приложении необходи-
мо добавить все заголовочные и исполняемые файлы в про-
ект. Исключение составляют два файла – «STM8_TSL_RC_
Configuration_TOADAPT.h» и «STM8_TSL_RC_routines.
asm». Первый копируется в директорию проекта и переимено-
вывается в «stm8_TSL_RC_Configuration.h». Второй добав-
ляется в проект только при использовании инструментария от 
Raisonance. Файлы «stm8_tsl_rc_api.h» и «stm8_tsl_rc_api.c» 
определяют функции API, переменные, структуры данных, 
константы для связи между библиотекой и кодом пользовате-
ля. Для использования библиотеки заголовочный файл «stm8_
tsl_rc_api.h» должен быть включен в основной исполняемый 
файл «main.c». Документ «stm8_TSL_RC_Configuration.h» 
содержит статические конфигурационные параметры, кото-
рые должны быть сконфигурированы в соответствии с аппа-
ратной частью проекта. Необходимо проверить все параме-
тры с префиксом «#define» в соответствии с правильными 
значениями. Более подробно работа с библиотекой будет рас-
смотрена в разделе «Проект discover».

Среда разработки ST Visual Developer
Для начала работы нам необходимо ознакомиться со сре-

дой разработки ST Visual Developer. В среде существуют два 
основных понятия – проект и рабочая область.

Одна рабочая область может содержать несколько про-
ектов. Это может быть удобно при разработке ПО. Рабо-
чая область создается или открывается через «File → New 
Workspace…» или «File → Open Workspace…». В уже соз-
данной рабочей области можно создавать, удалять и до-
бавлять новый проект через «Project → Add New Project to 
WorkSpace…», «Project → Remove Project from WorkSpace» 
или «Project →  Insert Project to WorkSpace…». Для работы 
с определенным проектом необходимо его сделать активным: 
«Project → Set Active Project». Все вышеописанные операции 
также можно выполнить, кликнув правой кнопкой мыши на 
проекте или рабочей области. Добавление папок и файлов в 
проект осуществляется кликом правой кнопки мыши на про-
екте или файле; в выпадающем меню вам будут доступны эти 
операции. Операции по компилированию и сборке проекта до-
ступны во вкладке основного меню «Build → Compile filename», 
«Build → Build», «Build → Rebuild All». Выбор программатора-
отладчика доступен во вкладке «Debug Instrument → Target 
Settings…», а все операции по отладке находятся во вкладке 
основного меню «Debug» и на дополнительной панели инстру-
ментов. Для отдельной настройки каждого проекта в среде, 
по умолчанию, доступны два режима конфигурации проекта – 
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«debug» и «release». Режим «debug» предназначен для исполь-
зования в режиме отладки. Режим «release» предназначен для 
автономной работы ПО в микроконтроллере без избыточной 
функциональности режима «debug». Каждый из режимов вы 
можете настроить персонально или создать свой собственный 
режим со специфичными для вас настройками. Более подроб-
ную информацию для работы со средой вы можете прочитать 
в соответствующем руководстве.

Структура пакета программного 
обеспечения микроконтроллера 
STM8S-Diccovery

Для дальнейшей работы нам необходимо скачать пакет 
программного обеспечения (примеры, библиотеки, файлы 
справки) для оценочного набора STM8S-Discovery (http://
compeljournal.ru/images/articles/discover_pack.zip 
(8,5 Мбайт)). Пакет имеет следующую структуру:

• «Libraries» – директория состоит из двух частей:
– STM8_TouchSensing_Driver – сенсорная библиотека с 

заголовочными, исполняемыми и справочными файлами;
– STM8S_StdPeriph_Driver – библиотека периферии с за-

головочными, исполняемыми и справочными файлами;
• «Project» – директория с примерами готовых проек-

тов:
– discover – проект демонстрирующий работу сенсорной 

библиотеки и библиотеки периферии;
– program_template – шаблон для быстрого создания про-

екта;
• Справочная информация.
Каждый проект состоит из трех поддиректорий:
• inc – в ней хранятся заголовочные файлы проекта, 

включая конфигурационные файлы для сенсорной библиоте-
ки (STM8_TSL_RC_Configuration.h) и библиотеки перифе-
рийных устройств (stm8s_conf.h);

• src – в ней хранятся все файлы исходных текстов, вклю-
ченные и используемые в проекте (main.c, stm8_interrupt_
vector.c и др.);

• STVD\(Raisonance, Cosmic) – в ней хранятся рабочие 
файлы проектов, областей, настроек (discover.stw).

Итак, копируем папки «Libraries» и «Project» в рабо-
чую область, где мы предполагаем их использовать, напри-
мер, в следующее местоположение: «C:\Program Files\
STMicroelectronics\st_toolset». Теперь запускаем среду раз-
работки «Пуск → Программы → ST Toolset → Development 
Tools – ST Visual Develop», кликаем «File → Open Workspace…» 
и открываем проект «discover» из папки «C:\Program Files\
STMicroelectronics\st_toolset\Project\discover\STVD\
Raisonance» или «C:\Program Files\STMicroelectronics\st_

toolset\Project\discover\STVD\Cosmic». Теперь мы можем 
скомпилировать, собрать, прошить микроконтроллер и запу-
стить программу на исполнение. Сборка проекта должна прой-
ти без каких-либо проблем, единственное, что понадобится 
сделать – это выбрать программатор-отладчик ST-Link через 
«Debug instrument → Target Settings → Swim ST-Link» (рис. 4). 
Если по каким-то причинам сборка проекта произошла с ошиб-
ками, ниже будут приведены все настройки проекта.

Самостоятельная настройка проекта
Если вы решили разместить проект, библиотеки, исходные и 

заголовочные файлы по вашему собственному усмотрению или 
создать проект «с нуля», то у вас могут возникнуть проблемы с 
линковкой файлов библиотек. Все пути к этим файлам можно 
прописать вручную, но это слишком загромождает проект и де-
лает ваш код менее наглядным. Ниже будут приведены основ-
ные настройки проекта для каждого из Си-инструментария 
в отдельности, и начнем мы с настройки инструментария от 
Raisonance. Заметим, что в качестве примера будет исполь-
зоваться проект «discover», скачанный по вышеприведенной 
ссылке. Переходим на «Projects → Settings…» (рис. 4).

В поле «Toolset» выбирается Си-инструментарий с необ-
ходимыми настройками, в нашем случае выбран инструмен-
тарий от Raisonance. В поле «Root path» указывается путь к 
Си-инструментарию, а в «Output directory» – режим конфи-
гурации проекта, для которого и будут применяться все на-
стройки; на рисунке 4 выбран режим «debug».

Следующая вкладка «Projects →  Settings… → 
Debug». В данной вкладке нас интересует поле «Source 
Directories:», где прописываются пути к используемым фай-
лам проекта с исходным кодом. Для проекта «discover» – 
это «С:\Program files\stmicroelectronics\st_toolset\
project\discover\src», «C:\Program files\stmicroelectronics\
st_toolset\libraries\stm8s_stdperiph_driver\src» и «C:\
Program files\stmicroelectronics\st_toolset\libraries\stm8_
touchsensing_driver\src».

Следующая вкладка «Projects →  Settings… →  MCU 
Selection». Здесь выбирается тип микроконтроллера – 
STM8S105C6 для выбранного нами оценочного комплекта.

Следующая вкладка – «Projects → Settings… → C Compiler» 
(рис. 5). В поле «Category» необходимо выбрать «Preprocessor» 
и далее в поле «Additional include directories» прописать пути 
к заголовочным файлам, используемым в проекте. Для про-
екта «discover» – это «C:\Program Files\STMicroelectronics\
st_toolset\Project\discover\inc», «C:\Program Files\
STMicroelectronics\st_toolset\Libraries\STM8_TouchSensing_
Driver\inc» и «C:\Program Files\STMicroelectronics\st_
toolset\Libraries\STM8S_StdPeriph_Driver\inc».

Рис. 4. свойства проекта Рис. 5. свойства проекта
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И последняя вкладка – «Projects →  Settings… → 
Linker». Если вы используете ограниченно-бесплатный Си-
инструментарий, то необходимо убрать флажок «Run Code 
Compressor», иначе при сборке проекта будет сгенерирована 
ошибка.

Что касается использования Си-инструментария от Cosmic 
Software, необходимо всего лишь произвести некоторые изме-
нения в поле «General» (рис. 6), остальные настройки иден-
тичны приведенным выше для Raisonance. В частности в поле 
«Toolset» выбирается Си-инструментарий от Cosmic software 
и соответствующие настройки.

В разделе, посвященном настройке проекта, были затро-
нуты лишь основные моменты. К сожалению, описать все на-
стройки и тонкости не хватит места, да и в этом, собственного 
говоря, нет необходимости. Для более детальной информа-
ции вам следует обратиться к руководству описания среды ST 
Visual Developer. Что касается приведенных выше настроек 
проекта – путей к файлам, вы можете пересобрать и переком-
поновать проект по вашему усмотрению, нужно лишь пропи-
сать правильные пути к исходным и заголовочным файлам. 
По мере работы со средой и приобретения опыта вы сами раз-
беретесь, какие настройки для чего необходимы.

Создание нового проекта, 
конфигурирование библиотек

Возможно, по каким-либо причинам у вас не возникнет 
желания использовать предоставляемые производителем би-
блиотеки. В таком случае вам понадобится следующая ин-
формация. Все файлы с описанием регистров находятся в 
папке «C:\Program Files\STMicroelectronics\st_toolset\
include». Пути для Си-компилятора прописываются в свой-
ствах проекта «Project → Settings → C compiler → Category 
Preprocessor». Свойства линковщика находятся в «Project →
Settings → Linker → Category Input».

Для создания собственного проекта с использованием би-
блиотек наиболее простым и быстрым методом является ис-
пользование шаблона проекта «Project_template», располо-
женного в скачанном пакете в папке «Project». При создании 
проекта вы вручную создаете папку с названием вашего проек-
та и копируете туда содержимое проекта «Project_template». 
Затем в среде ST Visual Develop открываем проект из вновь 
созданной папки (рис. 7). Структура проекта состоит из сле-
дующих директорий:

• Source Files – содержит исходные файлы проекта;
• Source Files\FWLib – содержит исходные файлы би-

блиотеки периферии;
• Source Files\TSLib – содержит исходные файлы сен-

сорной библиотеки;
• Include Files – содержит заголовочные файлы проекта;
• Include Files\FWlib – содержит заголовочные файлы 

библиотеки периферии;
• Include Files\STlib – содержит заголовочные файлы 

сенсорной библиотеки.
Далее нам необходимо выбрать в свойствах проекта 

программатор-отладчик, Си-инструментарий, тип микрокон-
троллера, прописать пути к файлам, если они не указаны. 
Эти операции описывались выше.

Для использования библиотеки стандартной перифе-
рии необходимо убедиться, что в основном файле проек-
та «main.с» был подключен файл «stm8s.h» (#include 
<stm8s.h>), который содержится в директории «inc» би-
блиотеки периферии микроконтроллера. Также файл 
«stm8s.h» необходимо добавить в поддиректорию «Include 
Files\FWlib», кликнув правой кнопкой мыши на папке, 
и выбрать в выпадающем меню «Add Files to Folder…» 
(рис. 7).

Шаблон проекта подразумевает, что разработчик будет ис-
пользовать библиотеку стандартной периферии микроконтрол-
лера. В другом случае вам нужно закомментировать строку 

Рис. 6. свойства проекта

«#define USE _ STDPERIPH _ DRIVER» в файле «stm8s.h». 
Если вы все же будете использовать библиотеку стандартной 
периферии, то вам необходимо выполнить следующие шаги:

1) Убедиться, что строка «#define USE _ STDPERIPH _
DRIVER» в файле «stm8.h» раскомментирована;

2) Добавить файл «stm8s _ conf.h» из директории ва-
шего проекта «My Project\inc» в папку корневого каталога 
«Include Files» проекта с помощью операции «правая кнопка 
мыши → Add Files to Folder…». Для использования какого-
либо периферийного модуля необходимо раскомментировать 
его название в файле «stm8s _ conf.h» (рис. 8);

3) Вся периферия и функции работы с ней описаны в двух 
файлах: заголовочном (расширение .h) и исходном (расши-
рение .с) с именем «stm8s_PeriphType». Данные файлы рас-
положены в директориях «inc» и «src» по следующему пути 
«C:\Program Files\STMicroelectronics\st_toolset\Libraries\
STM8S_StdPeriph_Driver». При использовании любого пери-
ферийного модуля в вашем проекте необходимо добавить исхо-
дный файл в поддиректорию «Source Files\FWLib», а заголо-
вочный – в «Include Files\FWLib» (рис. 8). Данные операции 
выполняются кликом правой кнопкой мыши на соответствую-
щей папке: «Правая кнопка мыши → Add Files to Folder…»

После вышеперечисленных действий вы можете использо-
вать функционал библиотеки периферии. В примере «discover» 
используется сенсорная кнопка, работа с которой реализована 
в специальной библиотеке. Для использования библиотеки ее 
необходимо сконфигурировать следующим образом:

Рис. 7. создание нового проекта
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1) Сконфигурировать библиотеку в соответствии с коли-
чеством сенсорных кнопок (до 24), ползунков (до двух) и 
колец (до двух):

• Скопировать файл «STM8_TSL_RC_Configuration_
TOADAPT.h» из директории «C:\Program Files\
STMic ro e l e c t r on i c s\ s t_ too l s e t\L ib r a r i e s\STM8_
TouchSensing_Driver\inc» в директорию проекта «C:\
Program Files\STMicroelectronics\st_toolset\Project\new_
project\inc» и переименовать данный файл в «STM8_TSL_
RC_Configuration.h»;

• Сконфигурировать файл «STM8_TSL_RC_
Configuration.h» в соответствии с аппаратными особенностя-
ми проекта;

• Добавить файл «STM8_TSL_RC_Configuration.h» в ди-
ректорию «Include Files» проекта: «правая кнопка мыши→Add 
Files to Folder…»;

• При использовании инструментария от Raisonance до-
бавить файлы с расширением «.h» и «.c», исключая файл 
«STM8_TSL_RC_Configuration_TOADAPT.h» из сенсор-
ной библиотеки C:\Program Files\STMicroelectronics\
st_toolset\Libraries\STM8_TouchSensing_Driver», соот-
ветственно, в директории «Include Files\TSLib» и «Source 
Files\TSLib» (рис. 9). При использовании инструментария от 
Cosmic Software файл «STM8_TSL_RC_routines.asm» также 
не добавляется, вместо него необходимо сконфигурировать 
«Project → Settings → Linker», что будет описано ниже;

• Добавить строчку «#include <stm8 _ tsl _ rc _ api.
h>» в основной файл проекта «main.c»;

• Некоторые функции библиотеки должны быть располо-
жены в памяти по специальным адресам при использовании 
инструментария Cosmic software (рис. 10):

– Выбираем «Project → Settings → Linker»;
– На вкладке «Linker» в поле «Category» выбираем 

«Input»;
– В поле «Vector File name» прописываем путь к файлу 

«stm8_interrupt_vector.c»;
– В окне «Segment/Section name» добавляем «TSL_IO_

ALCODE» в секции «Code,Constant» c опцией «-r2»;
• При использовании инструментария Raisonance в опе-

рациях с «Project → Settings → Linker» нет необходимости. 
Необходимо всего лишь добавить файл «STM8_TSL_RC_
routines.asm» в директорию проекта «Source Files\FWLib».

Общую настройку проекта с обеими библиотеками вы мо-
жете посмотреть на примере «discover» в загруженном паке-
те программного обеспечения.

Проект «discover»
Алгоритм работы программного обеспечения проекта сле-

дующий: программа ожидает срабатывания нажатия сенсора 
TS1 и меняет частоту мерцания светодиода LD1. Рассмотрим 
проект более подробно. Открываем среду разработки ST Visual 
Developer, затем «File → Open Workspace…» и выбираем проект 
по следующему пути C:\Program Files\STMicroelectronics\
st_toolset\Project\discover\STVD\Raisonance». Как вы мо-
жете заметить, у данного проекта структура фактически иден-
тична шаблону проекта «project_template» и используются 
обе библиотеки – сенсорная библиотека и библиотека перифе-
рии. Рассмотрим более подробно основные моменты основно-
го файла проекта «main.c».

#include «stm8s.h»
// Заголовочный файл библиотеки периферии
#include «stm8 _ tsl _ rc _ api.h»
// Заголовочный файл сенсорной библиотеки
// Макроопределения
……
// Объявление функций
……
// Объявление глобальных переменных
……
// Главная функция
void main(void)
{
//Конфигурация тактового сигнала
CLK _ Configuration();
// Конфигурация портов ввода/вывода
GPIO _ Configuration();
// Инициализация сенсорной библиотеки
TSL _ Init();
// Инициализация сенсорных кнопок
ExtraCode _ Init();
// Старт таймера для управления частотой
мерцания светодиода LD1 с периодом 100 мс
 TSL _ Tick _ Flags.b.User _ Start _ 100ms = 1;
// Основной цикл программы
for (;;)
{
// Код разработчика
ExtraCode _ StateMachine();
// Главная функция сенсорной библиотеки
TSL _ Action();
}
}
// Реализация объявленных функций
……
Программы для микроконтроллеров имеют похожие структу-

ры, точкой входа программы является функция «main()». Для 

Рис. 8. конфигурирование библиотеки периферии

Рис. 9. конфигурирование сенсорной библиотеки



НОВОСТИ ЭЛЕКТРОНИКИ № 6, 2010

ОБЗОРЫ

14

начала работы с микроконтроллером, в зависимости от задачи, 
его необходимо сконфигурировать – настроить тактовые часто-
ты, периферийные модули, разрешить прерывания, если необхо-
димо. После этого уже запускается т.н. диспетчер, обычно – это 
бесконечный цикл «while(1){….}» или «for(;;){….}», в контек-
сте которого уже и выполняются функции основной програм-
мы – реакция на события, выполнение вычислений и т.д.

В проекте из библиотеки стандартной периферии исполь-
зуются функции для настройки тактового сигнала, настройка 
работы с портами ввода/вывода. С помощью функции «CLK_
HSIPrescalerConfig(CLK_PRESCALER_HSIDIV1)» в качестве 
источника тактового сигнала выбирается внутренний генера-
тор HSI, работающий на частоте 16 МГц, коэффициент деле-
ния равен 1, соответственно рабочая частота микроконтролле-
ра равна 16 МГц. Для работы со светодиодом LD1 необходимо 
настроить соответствующую ему ножку ввода/вывода. Дан-
ная операция выполняется с помощью функции библиотеки 
«GPIO_Init(GPIOD, GPIO_PIN_0, GPIO_MODE_OUT_PP_
LOW_FAST)». По передаваемым параметрам функции видно, 
что используется ножка «0» порта «D» микроконтроллера, ре-
жим push – pull, режим быстрого переключения (до 10 МГц), 
и в данный момент на ее выходе – сигнал низкого уровня. 
Переключение состояния ножки осуществляется с помощью 
функции «GPIO_WriteReverse(GPIOD, GPIO_PIN_0)».

Процесс работы с сенсорной библиотекой начинается с 
ее инициализации: «TSL_Init()» – инициализация памяти, 
функций и структур данных. Далее необходимо настроить би-
блиотеку согласно аппаратным требованиям. В нашем случае 
библиотека настраивается под сенсорную кнопку TS1 в функ-
ции ExtraCode_Init(). После того, как все настроено, можно 
начинать работать с библиотекой, которая предоставляет API 
для работы с ней, нам в частности необходимо определять со-
бытие нажатия TS1. Данная операция осуществляется в функ-
ции «ExtraCode_StateMachine()», также здесь задается режим 
мерцания светодиода LD1. Для работоспособности сенсорной 
библиотеки необходимо включать в основной цикл програм-

Рис. 10. конфигурирование сенсорной библиотеки для Cosmic software

Получение технической информации, заказ образцов, поставка – 
e-mail: mcu.vesti@compel.ru

мы (диспетчер) функцию «TSL_Action()», которая выполняет 
необходимые операции для обработки и определения событий 
сенсорных кнопок и других сенсорных объектов.

Заключение
В статье мы представили необходимую информацию 

для начала работы с микроконтроллерами STM8. В мате-
риале были рассмотрены лишь основные моменты, для бо-
лее подробного и глубокого ознакомления читателю следует 
обращаться к справочным материалам, доступным на сайте 
http://www.st.com/mcu/.
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Р
ост спроса на микроконтрол-
леры (МК) с низким энерго-
потреблением вызван многими 
факторами. Во-первых, уве-

личивается число всевозможных пор-
тативных устройств с питанием от ба-
тареи, и время работы без подзарядки 
во многих случаях является определяю-
щим при выборе такого устройства. Во-
вторых, размер самой батареи напря-
мую зависит от напряжения питания и 
энергопотребления устройства, а поль-
зователи очень ценят компактность. И, 
в-третьих, сейчас практически во всем 

мире технологии становятся «зелены-
ми», и во многих странах принимаются 
соответствующие законы.

В платформу МК с ультраниз-
ким энергопотреблением компании 
STMicroelectronics теперь входят 8-бит-
ное семейство STM8L и 32-битное се-
мейство STM32L (рис. 1). Оба семей-
ства производятся по технологии 130 нм 
с низкими токами утечки. О семействе 
STM8L шла речь в №14 за 2009 год, 
поэтому рассмотрим STM32L.

МК STM32L15xx построены на базе 
32-битного RISC-ядра Cortex-M3, рабо-

тающего с частотой до 32 МГц (рису-
нок 2). Они содержат высокоскорост-
ную встроенную память (до 128 Кбайт 
FLASH и до 16 Кбайт RAM), 12-битный 
АЦП, два ЦАП, два компаратора, шесть 
таймеров общего назначения, два систем-
ных таймера и часы реального времени. 
Кроме того, STM32L15xx имеют множе-
ство стандартных и специализирован-
ных коммуникационных интерфейсов: 
до двух I2C и SPI, три USART и USB. 
Встроенный ЖКИ-контроллер позволя-
ет управлять внешними индикаторами.

STM32L15xx работает при напря-
жении питания 1,8...3,6 В, также есть 
возможность работы в диапазоне питаю-
щих напряжений 1,65...3,6 В.

 Развитая система режимов снижен-
ного энергопотребления дает возмож-
ность разрабатывать низкопотребляю-
щие устройства.

STM32L15xx поддерживают динами-
ческое изменение напряжения питания 
для оптимизации энергопотребления в ак-
тивном режиме работы. Для этого в МК 
встроен регулятор, который выдает необ-
ходимый уровень напряжения в зависимо-
сти от требующейся производительности 
и доступного источника питания. В актив-
ном режиме при выполнении программы 
из flash-памяти энергопотребление состав-
ляет 230...290 мкА/МГц в зависимости от 
частоты ЦПУ. Семь режимов сниженного 
энергопотребления позволяют подобрать 
лучшее соотношение энергопотребления 
со способом и скоростью возврата в ак-
тивный режим. В самом глубоком из них 
энергопотребление составляет 0,5 мкА 
(все выключено) и 1,3 мкА с включенны-
ми часами реального времени.

В число основных областей приме-
нения STM32L15xx входят портативные 
медицинские и носимые биометрические 
устройства, охранные системы, беспро-
водные системы, измерительные счетчи-
ки, навигационные устройства. МК до-
ступны в трех типах корпусов с числом 
выводов от 48 до 100. Рабочий темпера-
турный диапазон -40...85°С.

В статье рассказывается о новом семействе микроконтроллеров 
STM32L15xx от STMicroelectronics. Это семейство обладает низким энер-
гопотреблением и производится по технологии 130 нм. Оно найдет применение 
в портативных устройствах, системах с беспроводными датчиками, 
навигационных устройствах и др.

Новое семейство 
мК STM32L с ультраНизКим 
эНергопотреблеНием

Алексей Пантелейчук (г. Краснодар)

Рис. 1. платформа микроконтроллеров с ультранизким энергопотреблением

Рис. 2. блок-схема архитектуры STM32L15xx

Получение технической информации, 
заказ образцов, поставка – 
e-mail: mcu.vesti@compel.ru



НОВОСТИ ЭЛЕКТРОНИКИ № 6, 2010

ОБЗОРЫ

16

А
номальные явления в сетях воз-
никают эпизодически, и выя-
вить их можно с помощью реги-
страторов, способных работать 

в течение длительных периодов времени 
без присмотра пользователей. Данные 
устройства должны обладать невысокой 
ценой, необходимыми метрологическими 
характеристиками, способностью рабо-
тать от автономных источников, возмож-
ностью эксплуатации в жестких услови-
ях окружающей среды и др.

В России в настоящее время дей-
ствует стандарт [1], который дает фор-
мализованное описание т.н. показателей 
качества электрической энергии (ПКЭ): 
терминология, алгоритмы выделения из 
массивов оцифрованных данных, алго-
ритмы статистической обработки. Он 
же устанавливает и требования к точно-
сти измерений этих ПКЭ.

Опыт создания систем измерений 
(СИ) ПКЭ, удовлетворяющих в полной 
мере требованиям [1], показывает, что 
изделия получаются принципиально до-
рогими и малодоступными для широко-
го круга потенциальных потребителей. 
Мы пошли по другому пути.

В качестве модели для применения 
разрабатываемых нами СИ ПКЭ была 
выбрана деятельность специалистов-
аудиторов, выполняющих работы по 
т.н. энерготехнологическому аудиту 
энергетического и электротехнического 
оборудования предприятий различного 
назначения. Условия проведения такого 
рода аудитов достаточно жесткие, дли-
тельность их проведения – большая при 
множестве объектов контроля. Приме-
нение современных дорогостоящих СИ 
часто избыточно, в ряде случаев – ма-
лоэффективно, затратно и имеет огра-
ничения, например, по температурному 
диапазону применения.

Было решено существенно упростить 
как структурную схему (рис. 1), так и ее 
реализацию в создаваемых СИ ПКЭ.

1) Т.к. изделие должно осущест-
влять контроль ПКЭ в течение долго-
го времени, и присутствие пользователя 
при этом необязательно, то из структу-
ры были исключены развитые средства 
взаимодействия с оператором (полно-
ценные дисплей и клавиатура), которые 
ограничивают температурную область 
применения, усложняют, удорожают 
СИ, приводят в ряде случаев к суще-
ственному возрастанию тока потребле-
ния. В изделии сохранены только про-
стые служебные органы взаимодействия 
(отдельные светодиоды и кнопки). Что 
касается полноценного отображения по-
лучаемой измерительной информации, 
то мы его выполняем позднее – в ком-
пьютере. Для этого актуальная инфор-
мация в проектируемом изделии реги-
стрируется в извлекаемой flash-карте, и 
проектируемое изделие становится, та-
ким образом, регистратором.

2) Исключается интерфейсный адап-
тер.

3) Поскольку в последнее вре-
мя появились недорогие современ-
ные микроконтроллеры на ARM-ядре 
Cortex-M3 со следующими актуальны-
ми для нас особенностями: оптимизи-
рованное потребление, большой объем 
внутренней памяти, высокая произво-
дительность, встроенный 12-разряд-
ный АЦП, развитые коммуникацион-
ные возможности – стало возможным 
реализовать АЦП, процессор и устрой-
ство управления (рис. 1) в виде одной 
микросхемы.

Однако требования [1] выполняются 
в такой структуре далеко не в полной 
мере: погрешности измерений старших 
гармоник исследуемых сигналов могут 
быть в два раза больше требуемых по 
стандарту; может не соблюдаться огра-
ничение на время преобразования. При 
этом основной алгоритм выделения 
ПКЭ из массива оцифрованных значе-
ний остается.

Главное реализуемое преимущество 
таких регистраторов – их относительно 
низкая цена и стимулируемая этим фак-
том широкая востребованность. Струк-

В статье представлена информация о регистраторе напряжений 
на базе 32-разрядного ARM-контроллера STM32F103 производства 
STMicroelectronics, который позволит потребителю проводить длительную 
регистрацию исходных данных о фазных напряжениях в электрических сетях 
общего назначения.

РегистРатоР 
напРяжений 3-фазных сетей 
пеРеменного тока

Александр Шатохин, Петр Макарычев (МЭИ (ТУ))

Рис. 1. обобщённая структурная схема современных цифровых си
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турная схема реализованного регистра-
тора представлена на рис. 2.

Виды регистрации
Обработка данных в компьютере 

позволяет снизить требования к ми-
кроконтроллеру регистратора, задача 
которого в этом случае сводится к не-
прерывной оцифровке входных сигна-
лов и трансляции получаемых кодов в 
карту памяти. Такая «бездумная» реги-
страция потребует карт большого объ-
ема и существенного времени на об-
работку массивов уже в компьютере. 
Этот режим регистрации назовем не-
прерывным.

С целью экономии энергии приме-
няемых батарей и расширения длитель-
ности сеансов регистрации, регистратор 
может обрабатывать данные в програм-
мируемые заранее моменты времени. 
Регистрация при этом может осущест-
вляться либо равномерно во времени, 
либо выборочно. Этот режим регистра-
ции назовем зондовым.

Другой вид регистрации, который 
«экономит» память flash-карты, но тре-
бует больших энергетических затрат, 
назовем сторожевым. В этом режиме 
контроллер производит непрерывное 
преобразование поступающих данных, 
анализирует результаты преобразова-
ния и регистрирует только аномаль-
ные их значения. Заметим, что потре-
бляемая от источника питания энергия 
может быть оптимизирована в случае, 
если использовать эффективный алго-
ритм выявления аномалий, не требую-
щий высокой тактовой частоты микро-
контроллера.

Технические характеристики реализо-
ванного регистратора Р15КИНР01.01А

Конвертер (преобразователь) изме-
рительный носимый с регистрирующи-
ми функциями, семейство Росомаха, 
версия 01.01, производственная ревизия 
А, корпус типа OKW TOPTEC 154F об-
ладает следующими характеристиками:

• Зондовый или непрерывный тип 
регистрации;

• Вид регистратора – SD/MMC 
flash-карта нормального размера:

• Объем регистрируемых данных до 
2 ГБ;

• Продолжительность непрерывного 
сеанса регистрации одни сутки;

• Продолжительность зондового ре-
жима регистрации до нескольких меся-
цев;

• Питание от двух батарей типа 
АА;

• Рабочий диапазон температур 
-10...40°С;

• Входное сопротивление не менее 
1000 кОм;

• Габаритные размеры не более 
82х155х37 мм3

• Масса не более 500 г.

На рисунке 3 представлен вид раз-
работанного регистратора со снятой 
крышкой.

Принципиальная схема реализованно-
го регистратора

Выбор микроконтроллера. Как было 
сказано, микроконтроллер выбран сре-
ди современных 32-разрядных ARM 
Cortex-M3. Это STM32F103 европейской 
фирмы STM [2], которая раньше дру-
гих вышла на рынок с этим продуктом. 
Привлекательной особенностью семей-
ства STM32 является последовательно 
реализуемая фирмой концепция – соз-
дание в его рамках линеек с различны-
ми техническими акцентами: дешевые 
(access); с высокой производительно-
стью (performance); с большими объе-
мами памяти (density); с оптимизиро-
ванными объемами памяти и периферии 
(low&medium-density); с расширенны-
ми коммуникационными возможностями 
(connectivity); со сверхмалым потребле-
нием (ultra-low-power) и др. Разработ-
чик имеет возможность использовать 
один из выбранных типов и, освоив его, 
устанавливать в спроектированную пла-
ту другое изделие с наиболее подходя-
щими свойствами из того же семейства.

Важной особенностью микрокон-
троллеров STM32 для решаемой задачи 
является наличие прямого доступа АЦП 
к оперативной памяти. Используемый 

объем оперативной памяти 12 КБ, памя-
ти программ – 16 КБ.

Выбор компонентов входных цепей. 
Входные цепи (см. табл. 1) в регистра-
торе выполняют три функции: защиты 
измерительных каналов от перенапря-
жений, нормализации входных сигналов 
и низкочастотной фильтрации (рис. 4).

Защита реализована стандартным 
способом: на входе измерительного ка-
нала устанавливается варистор с плав-
ким предохранителем, а на входе филь-
тра нижних частот – защитные диоды.

Нормализатор входных сигналов 
выполнен в виде пассивного делителя 
(R1, R2) с источником смещения Eсм 
в половину диапазона преобразования 
встроенного однополярного АЦП. Не-
которую проблему составляет выбор 
резистора R1. Этот резистор обеспечи-
вает входное сопротивление регистра-
тора (1000 кОм) и принимает на себя 

Рис. 2. структурная схема реализованного регистратора значений фазных напряжений

Рис. 3. Регистратор Р15кинР01.01а

Рис. 4. функциональная схема входных цепей
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практически все входное напряжение, 
которое с учетом общепринятого запа-
са для подобных изделий принято рас-
считывать как 2,5х220 В = 550 В. Тре-
буемая номинальная или прецизионная 
мощность, таким образом, не превысит 
100 мВт. Точность выбираемого номи-
нала не обязана быть выше ±1%, т.к. 
мультипликативная погрешность мо-
жет быть скомпенсирована путем ка-
либровки. Расчетное значение для 
температурного коэффициента для ука-
занного выше температурного диапазо-
на – 25 ppm/°C. Важным требованием 
к выбираемому R1 для малогабаритного 
регистратора является минимизация его 
размеров.

После долгих поисков было приня-
то решение использовать в качестве R1 
два последовательно включенных рези-
стора типа MELF 0207-560 кОм компа-
нии Vishay. Дополнительным полезным 
свойством этих резисторов является 
«терпимость» к высоковольтным им-
пульсным напряжениям перегрузки.

Низкочастотная фильтрация входных 
сигналов осуществляется в два этапа: с 
помощью двухполюсного аналогового 
фильтра, а затем – посредством цифро-
вого фильтра, реализуемого программно 
в микроконтроллере (см. далее).

Использование цифрового фильтра 
позволило снизить метрологические тре-
бования к пассивным компонентам ана-
логового фильтра. Точность выбранных 
номиналов резисторов не обязана пре-
вышать ±1%, а конденсаторов ±5%.

Актуальные требования к используе-
мым в ФНЧ операционным усилителям: 
рабочая полоса частот 0...1 МГц; ско-
рость нарастания больше 500 мВ/мкс; 
малый входной ток; способность рабо-
тать от однополярного напряжения; по-
требление меньше 100 мкА/канал. Как 
вариант был выбран двухканальный 
усилитель AD8542.

Основной алгоритм работы 
регистратора

Временная диаграмма, поясняющая 
работу регистратора в состоянии «Ре-
гистрация данных», представлена на 
рис. 5. Регистрация данных выполня-
ется регулярно с периодом Tр, равным 
двум секундам. Значение этого периода 
обеспечивается часами реального вре-
мени (RTC), встроенными в микрокон-
троллер (МК).

Сначала выполняется сбор данных в 
течение 200 мс. При этом системная ча-
стота микроконтроллера устанавливает-
ся на максимум (72 МГц). На данном 
интервале необходимо одновременно 
преобразовывать в код мгновенные на-
пряжения по четырем каналам. Встро-
енный в микроконтроллер АЦП1 строго 
реализовать это действие не позволяет. 
Однако благодаря широкому спектру 
режимов работы и запуска АЦП1 мож-
но «практически точно» реализовать 
отмеченное действие. В данном слу-

чае используется прерывистый режим 
функционирования АЦП1, который 
компания-производитель МК назвала 
Discontinuous mode [3]. Этот режим, 
иллюстрируемый рис. 6, использует-
ся для последовательного преобразо-
вания в код напряжений ограниченной 
(до восьми) группы каналов АЦП1. Эта 
группа является частью последователь-
ности каналов преобразования, задан-
ной в регистре специальных функций 
микроконтроллера ADC_SQR1. Как 
видно из рис. 6, после очередного за-
пуска группа регулярных преобразова-
ний выполняется без задержек. Число 
каналов в группе и их последователь-
ность программируется. В данном слу-
чае числа совпадают и равны четырем. 
Запуск группы осуществляется с по-
мощью сигнала TIM3_TRGO таймера 
TIM3. При выбранной тактовой часто-
те АЦП1 (9 МГц) длительность цикла 
преобразования Tц составляет пример-
но 1,55 мкс.

Таблица 1. список основных примененных электронных компонентов

Тип Назначение//Производитель
STM32F103C6 Микроконтроллер//STM

AD8542ARU Два микромощных ОУ//Analog Devices

LTC3429ES6 Повышающий стабилизатор//Linear Technology

SPX5205M-3-3 LDO-стабилизатор//Exar-Sipex

SiT8002AI-33-33 MEMS-генератор//SiTime

C-00RX – 32,768 кГц Кварцевый резонатор с гибкими выводами//Epson-Toyocom

CR 2025 PCB Элемент резервного питания впаиваемый//Panasonic

BLM21AG601SN1D Чип-феррит 0805//Murata

BAV199 Два защитных диода//NXP

ESDA5V3L Два TVS-диода//STM

BAS40-05 Два диода Шотки с общим катодом//NXP

IRLML6401 P-канальный МОП-транзистор//International Rectifier

DO1608-682 Индуктивность 6,8 мкГ/1,4 А//Coilcraft

CR0603 Чип-резисторы общего назначения, размер 0603 ±5%/100ppm/°C//Bourns

RT0603 Чип-резисторы прецизионные, размер 0603 ±1%/25 ppm/°C//Yageo

MELF 0207 Чип-резисторы прецизионные, размер 0207 ±1%/25 ppm/°C//Vishay

SIOV-Q20K300 Варистор диаметром 20 мм/600 В//EPCOS

Рис. 5. Временная диаграммы регистратора в состоянии «Регистрация данных»

Рис. 6. последовательность преобразования каналов
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Поскольку верхняя частота спек-
тра не превышает 2,3 кГц, то можно 
считать, что выборки по разным кана-
лам производятся практически одно-
временно. Первые три канала служат 
для получения цифровых отсчетов фаз-
ных напряжений. Четвертый канал по-
зволяет измерить специально введен-
ное смещение в первых трех каналах, 
чтобы обеспечить униполярное напря-
жение на входе АЦП1. Код этого сме-
щения при формировании записи вы-
читается из цифровых отсчетов фазных 
напряжений.

Для устранения наложения спектров 
применена двухступенчатая фильтра-
ция. Сначала входной сигнал каждого 
из трех каналов проходит через анало-
говый фильтр Баттерворта третьего по-
рядка, схема которого представлена на 
рис. 7.

Для развязки динамического входа 
АЦП1 и выхода операционного усили-
теля фильтра служит фильтр первого 
порядка (R4-C7) с небольшой постоян-
ной времени. С целью ослабления вли-
яния отклонения параметров элементов 
фильтра от номинальных значений ча-
стота среза фильтра Баттерворта вы-
брана примерно 5 кГц. Однако в этом 
случае не обеспечивается достаточное 
подавление в полосе заграждения филь-
тра. Поэтому применена вторая ступень 
фильтрации в цифровой форме с избы-
точной частотой дискретизации на вхо-
де фильтра и децимацией на выходе.

Был выбран трехкаскадный CIC-
фильтр с децимацией из-за его простой 
реализации [4]. Структурная схема это-
го фильтра представлена на рис. 8, где 
I – цифровой интегратор; R – опера-
ция децимации (прореживание отсчетов 
с коэффициентом R); С – гребенчатый 
фильтр, представляющий в данном слу-
чае цифровой дифференциатор первого 
порядка. Входная частота дискретиза-
ции Fs CIC-фильтра составляет 60 кГц, 
коэффициент децимации равен восьми. 
Амплитудно-частотные характеристики 
аналогового фильтра, цифрового филь-
тра и их результирующая АЧХ пред-
ставлены на рис. 9.

Недостаток CIC-фильтра – непло-
ская АЧХ в полосе пропускания. Эта 
проблема может быть решена двумя пу-
тями. Во-первых, применяют цифро-
вой корректирующий фильтр, который 
подключается к выходу CIC-фильтра 
и работает на частоте Fs/R. С целью 
упрощения программного обеспечения 
регистратора использован второй под-
ход, основанный на свойстве всех циф-
ровых фильтров – стабильности АЧХ. 
Поскольку накопленные на MMC-карте 
цифровые значения сигналов затем счи-
тываются в компьютер, то в нем влия-
ние спада АЧХ цифрового фильтра мо-
жет быть скомпенсировано или путем 
дополнительной корректирующей филь-

трации, или путем соответствующего 
масштабирования гармоник сигнала.

На этапе сбора данных осуществля-
ется дискретизация по четырем кана-
лам с частотой 60 кГц. Порции цифро-
вых отсчетов АЦП1 накапливаются в 
небольшом циклическом буфере канала 
прямого доступа к памяти (ПДП). Когда 
половина буфера заполнится, вырабаты-
вается прерывание, которое использует-
ся для считывания накопленных отсче-
тов и их обработки цифровым фильтром, 
с выхода которого данные поступают в 
буфер регистрации. На этом интервале 
параллельно заполняется вторая поло-
вина циклического буфера ПДП. Когда 
она заполнится, вырабатывается преры-
вание, используемое аналогичным об-
разом. Этот процесс повторяется до тех 
пор, пока не заполнится буфер регистра-
ции, содержащий отсчеты по трем кана-

лам. Отметим, что отсчеты в буфер ре-
гистрации поступают с частотой 7,5 кГц. 
Четвертый канал обрабатывается осо-
бенным образом: его цифровые отсчеты 
не подвергаются цифровой фильтрации, 
а используются для измерения среднего 
значения смещения.

По окончанию сбора данных систем-
ная частота МК снижается до 8 МГц с 
целью уменьшения потребляемой мощ-
ности от источника питания. На этапе 
формирования записи из накопленных 
в буфере цифровых отсчетов вычита-
ется смещение, и запись дополняется 
значениями текущего времени, коэффи-
циентами преобразования по каждому 
каналу и частотой дискретизации Fs.

Далее сформированная запись пере-
писывается на MMC-карту. Важным 
параметром для этой карты является 
длительность программирования бло-

Рис. 7. Электрическая принципиальная схема аналогового фильтра

Рис. 8. структурная схема трехкаскадного CIC-фильтра

Рис. 9. аЧх аналогового и цифрового фильтров и их результирующая аЧх
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ка Tprog, которая определяется тремя 
параметрами: TAAC, NSAC и R2W_
FACTOR [5]. Эти значения можно по-
лучить при считывании регистра CSD 
MMC-карты. Значения этих параме-
тров достаточно широко варьируются 
для разных типов карт. Оценить Tprog 
можно по следующей формуле:

 (1)

где Fspi – частота интерфейса SPI, 
используемого для связи с ММС-карт.

Минимальное значение Tprog,min в 
основном определяется TAAC и R2W_
FACTOR. Оценки показывают, что 
Tprog,min может находиться в диапа-
зоне от единиц до сотен миллисекунд. 
В данном регистраторе буфер записи 
имеет емкость примерно 9 КБ, чтобы 
можно было работать с относительно 
медленными ММС-картами. Уменьше-
ние емкости буфера возможно, если ис-
пользовать достаточно быстродейству-
ющие карты и осуществлять запись и 
накопление данных поблочно на этапе 
сбора данных.

По окончании записи МК перехо-
дит в режим «Sleep» для дальнейшего 
уменьшения потребления от источника 
питания. Периодически (через 10 мс) 
он выводится из этого состояния преры-

ванием системного таймера, обработчик 
прерывания которого сканирует клавиа-
туру и управляет индикацией.
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STM32 Value Line

Компания STMicroelectronics, 
один из ведущих производите-
лей микроконтроллеров в мире, 
анонсировала начало производ-
ства нового 32-битного дешевого 
микроконтроллера, использующе-
го преимущества индустриального 
STM32-ядра и разработанного для 
недорогих приложений. 
Микроконтроллеры семейства 
STM32F100 («Value line») пред-
назначены для применений, где 
мощность 16-битного микрокон-
троллера уже недостаточна, а бога-
тый набор функционала обычных 
32-битных микроконтроллеров 
избыточен. Линейка микрокон-
троллеров STM32F100 базирует-
ся на современном 24 МГц ARM 
Cortex–M3-ядре с периферией, 
оптимизированной для примене-
ния в типичных приложениях, где 
использовались 16-битные микро-
контроллеры. Производительность 
этой линейки на 24 МГц, вкупе с ну-
левыми задержками при доступе ко 
встроенной флеш-памяти, состав-
ляет 30 DMIPS, что превосходит 
большинство 16-разрядных микро-
контроллеров. Линейка включает 
следующую периферию – до 12-ти 
16-битных таймеров с расширенны-
ми функциями, высокоскоростные 
12-битные АЦП и ЦАП; протокол 
CEC (Consumer Electronics Control), 
включенный в HDMI стандарт. 
STM32F100 – это не только деше-
вый и оптимизированный микро-
контроллер на ядре Cortex-M3, но 
и доступ к богатой среде разработ-
ки микроконтроллеров семейства 
STM32, которая включает в себя 
бесплатные библиотеки для всей 
периферии, управление мотора-
ми и сенсорными клавиатурами. 
Вдобавок, при работе с микрокон-
троллерами STM32F100 всегда есть 
возможность легко перейти на ми-
кроконтроллеры с более высокой 
функциональностью, если это по-
требуется. На данный момент об-
щая номенклатура STM32 состоит 
из пяти семейств и составляет бо-
лее 110 позиций, предоставляя ши-
рокий выбор для разнообразных 
приложений.
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М
икросхемы семейства 
STPMxx построены по ар-
хитектуре, изображенной 
на рисунке 1. 

Аналоговая часть включает не-
сколько входных каналов для измере-
ния тока и напряжения, предусилите-
ли, дельта-сигма АЦП первого порядка, 
схему детектирования вмешательства в 
электросчетчик (с целью хищения элек-
троэнергии), генератор опорного напря-
жения, регулятор напряжения. В свою 
очередь, в цифровую часть входит си-
стемный модуль, специализированный 
DSP для вычисления электрических па-
раметров, осциллятор и интерфейс SPI. 
Управление производится с помощью 
конфигурирования регистров через SPI.

Микросхемы имеют один дифферен-
циальный вход для измерения напря-
жения и до двух дифференциальных 
входов для измерения тока. Вход для 
напряжения содержит дифференциаль-
ный усилитель с коэффициентом усиле-
ния 4. Максимальное дифференциаль-
ное напряжение для этого входа ±0,3 В. 
Два входа для измерения тока мульти-
плексируются, после чего поступают на 
предусилитель с коэффициентом усиле-
ния 4. После предусилителя идет про-
граммируемый усилитель с выбирае-
мым коэффициентом усиления: 2, 4, 6, 
8 (для STPM10 только 2 и 8). В резуль-
тате входной сигнал усиливается в 8,16, 
24 или 32 раза (8 или 32 для STPM10). 
Коэффициент усиления задается через 
специальный регистр и может отличать-
ся для двух входов для измерения тока. 
Если функция обнаружения хищения 
электроэнергии не используется, один 
из входов можно отключить.

Во внутренних регистрах STPMxx 
доступна очень важная информация для 

систем измерения потребления элек-
троэнергии, а именно – два значения 
активной мощности: общая активная 
мощность, вычисленная с учетом всех 
гармоник (до пятидесятой), и активная 
мощность первой гармоники. Вторая по-
лучается из первой путем фильтрации. 
Оба значения активной, а также реак-
тивная и полная мощности имеют раз-
решение 20 бит.

STPM01 и STPM10, помимо мощ-
ности, измеряют среднеквадратиче-
ские значения напряжения и тока сети. 
Вследствие динамического изменения 
напряжения, действительные значения 
его измеряются с разрешением 11 бит, в 
то время как действительные значения 
тока — с разрешением 16 бит. Мгновен-

ные значения напряжения и тока также 
доступны с разрешением 11 и 16 бит, 
соответственно. Частота сети измеряет-
ся с точностью 14 бит.

Измеренные значения активной мощ-
ности преобразуются в последовательно-
сти импульсов с частотой, пропорцио-
нальной измеренному значению. Этот 
импульсный сигнал используется при 
калибровке электросчетчика. Благода-
ря специальному алгоритму вычисления 
электрических характеристик, калибров-

ка STPM01 выполняется очень просто и 
быстро, и только для одного значения 
тока во всем диапазоне. Калибровочные 
параметры навсегда сохраняются в од-
нократно программируемой памяти, что 
препятствует их изменению.

Микросхемы STPMxx выпускаются 
в корпусах TSSOP20, работают в темпе-
ратурном диапазоне от -40 до 85°С, со-
ответствуют спецификациям IEC62052-
11, IEC62053-2X и отличаются друг от 
друга числом входных каналов, под-
держиваемыми датчиками тока и коли-
чеством измеряемых электрических ха-
рактеристик (таблица 1).

Микросхема STPM01 способна ра-
ботать в автономном режиме, самостоя-
тельно измеряя электрические характе-
ристики, управляя шаговым приводом 
через специально предназначенные для 
этого выводы и передавая по интер-
фейсу SPI информацию о вмешатель-
стве в схему. Но чаще всего микросхе-
мы STPMxx используются в сочетании 
с микроконтроллером для реализации 
однофазных и трехфазных счетчиков 
электроэнергии. Как известно, ком-
пания STMicroelectronics имеет мно-
жество развитых семейств микрокон-

троллеров для различных применений. 
Среди них есть микроконтроллеры, ко-
торые как нельзя лучше подходят для 
совместной работы с STPMxx в элек-
тросчетчиках. Это 8-битные микрокон-
троллеры STM8 для бюджетных реше-
ний c низким энергопотреблением и 
STM32 для производительных функ-
циональных устройств. Для начала 
рассмотрим пример построения одно-
фазного счетчика на базе STM8L152 и 
STPM10 (рисунок 2).

В отличие от других услуг, использование которых возможно без учета (го-
рячее и холодное водоснабжение, газ, отопление), оплата за электроэнергию 
производится в соответствии с показаниями приборов. Поэтому в интересах 
потребителя (как в быту, так и на производстве) – иметь точный, информа-
тивный, удобный в использовании (бесшумный, компактный) электросчет-
чик. Всем этим требованиям удовлетворяют решения на базе специализи-
рованных микросхем STPMxx компании STMicroelectronics в сочетании с 
микроконтроллерами серий STM8L и STM32L, о которых пойдет речь в 
этой статье.

Решения 
для измеРения мощности 
на основе мК STM 

Алексей Пантелейчук (г. Краснодар)

Решение по измерению электроэнергии на базе STPM01 и 
STM32F103 производства STMicroelectronics характеризуется 
высокой точностью измерений, гибкостью при выборе датчика 
тока, простотой калибровки, функциональностью, способностью 
отслеживать вмешательства в электросчетчик с целью хищения 
электроэнергии, возможностью передачи данных различными 
способами (USB, CAN, SPI, USART, I2C).
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Особенности микроконтроллера 
STM8L152:

• Производительность 16 МГц;
• Пять режимов энергопотребления;
• 1 мкА с RTC и сохранения данных 

ОЗУ;
• Переход в активный режим за 5 

мкс;
• Аналоговая часть (АЦП, ЦАП, 

компараторы) работающая на 1,8 В;
• Развитые функции безопасности;
• Контроллер прямого доступа к па-

мяти.
Особенности микросхемы STPM10:
• Измерение активной, реактивной 

и полной мощности, действующих зна-
чений тока и напряжения, частоты;

• Поддержка токовых трансформа-
торов и шунтов;

• Точность измерений 0,1;
• Обнаружение хищения электроэ-

нергии;
• Соответствие IEC61036, EN62056-

31, ANSI C12.1.
В рассматриваемом примере STPM10 

с высокой точностью измеряет ток, на-
пряжение и мощность однофазной сети. 
В качестве датчика используется токо-
вый трансформатор. Измеренные зна-
чения передаются по интерфейсу SPI в 
8-битный микроконтроллер STM8L152, 
который, в зависимости от требований 
решаемой задачи, сохраняет эти данные 
в памяти, отображает на индикаторе и/
или передает их другим устройствам. 
8-битные STM8L совместимы с 32-бит-
ными микроконтроллерами STM32L. 
Это означает, что при необходимости 
данное решение легко масштабировать 
(увеличить производительность, объем 
памяти, число коммуникационных ин-
терфейсов и т.д.). Благодаря использо-
ванию двух токовых трансформаторов 
(STPM10 имеет два входа для измере-
ния тока) и наличию встроенной схемы 
детектирования вмешательства, произво-
дится определение факта хищения элек-
троэнергии. Если в приложении требует-
ся измерять только мощность, STPM10 
можно заменить на STPM11/12 (без де-
тектирования хищения электроэнергии) 
или на STPM13/14.

Такое решение отличается низким 
энергопотреблением, высокой точно-
стью измерений, надежностью передачи 
и хранения данных, а главное, низкой 
стоимостью. Кроме этого, компанией 
STMicroelectronics разработана оценоч-
ная плата (рисунок 3) для демонстра-
ции работы решения на базе STM8L152 
и STPM10. Все схемы аппаратной части 
и коды программ приложения доступ-
ны для разработчиков, что дает возмож-
ность снизить цену электросчетчика не 
только за счет компонентов, но также – 
трудозатрат и времени разработки.

Основные характеристики оценоч-
ной платы:

• Измеряемое номинальное напря-
жение: 240 В AC;

• Измеряемый номинальный ток: 
5 А (тип.)/30 А (макс.);

• Рабочий диапазон: от 0,6 до 
1,2 В;

• Класс точности: 1,0
• ЖКИ-дисплей: 6 + 1 символов;
• Разрешающая способность: 

0,01 кВт/час;
• Детектирование вмешательств: об-

ратный ток, потеря нейтрали, вскрытие 
корпуса;

• Датчик: токовый трансформатор, 
шунт;

• Коммуникация: IrDA, оптическая.
Более мощное по производительности 

и функциональности устройство измере-
Рис. 3. оценочная плата для электросчетчика 
STM8L152 + STPM10

Рис. 1. Блок-схема STPM01

Таблица 1. основные отличия микросхем STPMxx

Устройство Измеряемые 
величины

Поддерживаемые 
датчики

Входные 
каналы (V+I)

STPM01 P, Q, S, Irms, Vrms, 
V, I

Токовый трансформатор, 
шунт, катушка Роговского

1 + 2

STPM10 P, Q, S, Irms, Vrms, 
V, I

Токовый трансформатор, 
шунт

1 + 2

STPM11, STPM12 P
Токовый трансформатор, 
шунт, катушка Роговского

1 + 1

STPM13, STPM14 P
Токовый трансформатор, 
шунт, катушка Роговского

1 + 2

Рис. 2. однофазный электросчетчик на базе STM8L152 и STPM10



НОВОСТИ ЭЛЕКТРОНИКИ № 6, 2010

ОБЗОРЫ

23

Получение технической информации, 
заказ образцов, поставка – 
e-mail: mcu.vesti@compel.ru

ния электрических характеристик мож-
но построить на базе микроконтроллеров 
STM32 и микросхемы STPM01 (рису-
нок 4). В отличие от STPM10, ко входу 
STPM01, помимо токового трансформа-
тора и шунта, можно в качестве датчи-
ка тока подключать катушку Роговского 
(хотя в рассматриваемом примере ис-
пользуется токовый трансформатор).

Особенности микроконтроллера 
STM32F103:

• Ядро Cortex-M3, 72 МГц;
• 7 каналов DMA;
• до 128 КБ FLASH, до 20 КБ 

RAM;
• 2 АЦП 12-бит (16 каналов), 

1 мкс;
• Встроенный RC-осциллятор 

8 МГц;
• Встроенный RC-осциллятор 

40 кГц;
• До 7 таймеров;
• USB 2.0, CAN, 2 SPI, 3 USART, 

2 I2C.
Особенности микросхемы STPM01:
• Измерение активной, реактивной 

и полной мощности, действующих зна-
чений тока и напряжения, частоты;

• Поддержка токовых трансформа-
торов, шунтов, катушек Роговского;

• Точность измерений 0,1;
• Обнаружение хищения электроэ-

нергии;
• Соответствие IEC62052-11, 

IEC62053-2X.

Рис. 4. однофазный электросчетчик на базе STM32F103 и STPM01

Решение на базе STPM01 и 
STM32F103 характеризуется высокой 
точностью измерений, гибкостью при 
выборе датчика тока, простотой кали-
бровки, функциональностью, способ-
ностью отслеживать вмешательства в 
электросчетчик с целью хищения элек-
троэнергии, возможностью передачи 
данных различными способами (USB, 

CAN, SPI, USART, I2C). На сайте 
компании-производителя доступно пол-
ное описание рассматриваемого приме-
ра, схемы реализации аппаратной ча-
сти, коды программ.
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К
омпания STMicroelectronics 
(STM), ставшая по мнению 
авторитетной аналитической 
компании iSuppli восходя-

щей звездой и номером один на рын-
ке МЭМС-датчиков движения в 2008 
году [1], по-прежнему остается веду-
щим игроком на этой арене. Успех ком-
пании связан с передовыми рабочими 
характеристиками их продукции, кото-
рые дополняются малыми габаритами, 
простой применения, экономичностью 
и адекватной стоимостью. Ассортимент 
МЭМС-датчиков компании STM пре-
имущественно составляют акселероме-
тры и гироскопы [2, 3], позволяющие 
контролировать параметры линейных и 
угловых перемещений, соответственно. 
Текущий год ознаменовался появлением 
в ассортименте STM новой оригиналь-
ной МЭМС-продукции: трехосевых ги-
роскопов L3G4200D/DH с цифровым 
выходом и модуля цифрового компаса 
LSM303DLH.

Свой первый трехосевой гироскоп 
LYPR540AH компания STM предста-
вила в ноябре прошлого года. Этот 
МЭМС-датчик размещен в корпусе с 
размерами 4,4x7,5x1,1 мм и поддержи-
вает два диапазона контроля угловых 
скоростей (±400 и ±1600 град/с). Вы-
вод результатов измерений, так же как 
и у одно- и двухосевых предшествен-
ников [3], организован на усиленных 
и неусиленных аналоговых выходах. 
По сравнению с LYPR540AH трехосе-
вые новинки этого года L3G4200D/
DH существенно отличаются в сторону 
улучшения рабочих характеристик за 
счет расширения диапазона контроли-
руемых угловых скоростей (поддержи-
ваются три диапазона ±250/500/2000 
град/с), применения цифрового SPI/
I2C-совместимого интерфейса для вы-

вода данных, возможности перевода в 
экономичные режимы работы с малым 
потребляемым током (режим SLEEP: 
1,5 мА; режим POWER-DOWN: 
5 мкА) и размещения в ультракомпакт-
ном корпусе LGA-16 (4х4х1 мм). До-
биться столь существенного отрыва в 
рабочих характеристиках удалось бла-
годаря использованию единой измери-
тельной структуры для контроля движе-
ния в трех ортогональных осях взамен 
традиционного подхода с использовани-
ем трех измерительных структур, как в 
случае LYPR540AH. Кроме того, при-

менение единой измерительной структу-
ры исключает проблему взаимного вли-
яния, что положительно сказывается на 
точности измерений и способствует сни-
жению потребляемого тока в активном 
режиме работы примерно на 40% – до 
уровня 6,1 мА (номинальное значение). 
Значения угловых скоростей выводятся 
в 16-битном формате. Обе микросхемы 
рассчитаны на работу при напряжении 
питания 2,4...3,6 В и в промышленном 
диапазоне температур -40...85°С.

Перечисленные характеристики яв-
ляются общим набором особенностей 
для L3G4200D/DH, а разобраться с 
их отличиями поможет рисунок 1. Из 
представленной здесь структурной схе-
мы видно, что L3G4200DH отличает-
ся повышенной степенью интеграции. 
У L3G4200DH предусмотрен 96-уров-
невый буфер FIFO, который позволя-
ет накопить 32 набора значений угло-
вых скоростей относительно осей x, y 
и z. Использование буфера FIFO позво-
лит снизить частоту генерации преры-
ваний управляющего процессора, что, 
как следствие, дает ему возможность 
дольше находиться в дежурном режиме 
работы и, в конечном счете, позволяет 
существенно снизить средний потребля-
емый системой ток. L3G4200DH содер-
жит дополнительный АЦП для 8-битной 
оцифровки напряжения встроенного 
датчика температуры, что дает возмож-
ность избавиться от внешней ИС датчи-

ка температуры в системах, где необхо-
дима функция контроля температуры. 
Наличие у L3G4200DH буфера FIFO 
отразилось и на различиях в назначе-
нии выводов. В отличие от L3G4200D, 
у микросхемы с индексом DH вывод го-
товности данных (DRDY) имеет альтер-
нативное назначение – выход генера-
ции прерывания по заполнению буфера 
(INT2).

Благодаря малым размерам и низ-
кому потребляемому току L3G4200D/

В статье рассказывается о трехосевых гироскопах L3G4200D/DH с 
цифровым выходом и модулем цифрового компаса LSM303DLH – новинках 
текущего года от лидера МЭМС-индустрии – компании  STMicroelectronics. 
Эти новинки отличаются улучшенными рабочими характеристиками и нахо-
дят разнообразное применение в системах навигации, системах безопасно-
сти, промышленной электронике, в 3D-пультах дистанционного управ-
ления и др.

Несмотря на первоочередную ориентацию на потребитель-
ские применения, модуль цифрового компаса LSM303DLH от 
STMicroelectronics может с успехом использоваться в разноо-
бразных промышленных приложениях: в системах навигации лю-
бых транспортных средств; охранных системах и системах безопас-
ности; строительном оборудовании; системах позиционирования 
антенн; автоматических системах выравнивания; в буровом обору-
довании; в системах управления автомобильным движением (в т.ч. 
в парковочных системах); в метеорологическом и геофизическом 
оборудовании (в т.ч. при мониторинге сейсмоактивности), а также 
в робототехнике. 

Новые 
МЭМС-датчики 
STMicroelecTronicS

Константин Староверов (г. Донецк)
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L3G4200DH перспективны для при-
менения в набирающих популярность 
3D-пультах дистанционного управле-
ния (например, для совместной рабо-
ты с презентационным оборудованием) 
и 3D-манипуляторах «мышь», кото-
рые обеспечивают работу с системами 
трехмерного моделирования, включая 
компьютерные игры и САПР, через 
интуитивно-понятный интерфейс. Кро-
ме того, эти трехосевые гироскопы 
могут применяться в системах пози-
ционирования для повышения точно-
сти устройств спутниковой навигации 
и сохранения ее работоспособности в 
условиях нестабильного или полного 
отсутствия приема спутниковых сиг-
налов. Пример – на рисунке 2. Здесь 
представлена структура системы авто-
матического мониторинга транспорта, 
предназначенной для формирования 
информации о местоположении транс-
портных средств в реальном времени. 
Для повышения точности спутниковой 
навигации дополнительно учитывают-
ся данные об инерциальном движении, 
которые оцениваются с помощью гиро-
скопа и имеющегося в составе любого 
современного транспортного средства 
одометра (датчик количества оборотов 
колеса, предназначенный для измере-
ния пройденного пути). После обра-
ботки всей оперативной информации 
формируются более точные данные о 
положении, направлении и скорости 
движения, которые передаются в ком-
муникационный центр через РЧ-канал, 
а затем выводятся на экран в диспет-
черской и отправляются другим систе-
мам. Помимо L3G4200D/L3G4200DH 
отличным кандидатом для работы в по-
добном применении может служить мо-
дуль LSM320HAY30, который в 28-вы-
водном корпусе LGA (4,4x7,5x1,1 мм) 
интегрирует трехосевой акселерометр и 
двухосевой гироскоп (pitch, yaw). Та-
кой модуль способен полностью кон-
тролировать движение инерциальной 
системы, избавляет от необходимо-
сти использования одометра и создает 
предпосылки для беспроводной реали-
зации устройства мониторинга.

Следующий участник данного об-
зора является плодом сотрудничества 
STM и известного новатора в области 
измерительных технологий – компа-
нии Honeywell. Разработанная послед-
ней анизотропная магниторезистивная 
(AMR) технология позволяет создавать 
магниточувствительные элементы, спо-
собные контролировать силу и направле-
ние магнитного поля Земли и определять 
направление по отношению к Северному 
магнитному полюсу. Помимо лучшей в 
своем классе точности технология AMR 
обеспечивает малое электропотребление, 
автоматическую компенсацию смещений 
(исключает необходимость калибров-
ки) и способность работать в условиях 

очень малой напряженности магнитно-
го поля, в т.ч. внутри автомобилей и 
зданий из металлоконструкций, а так-
же в географических зонах с больши-
ми значениями широты, включая север 
РФ. Перечисленные возможности раз-
работки Honeywell теперь доступны в 
новой продукции компании STM – мо-
дуле цифрового компаса LSM303DLH. 
В дополнение к магнетометру модуль 
содержит трехосевой акселерометр (по 
набору регистров и программированию 
идентичен LIS331DLH/M/F). Появле-
ние LSM303DLH является ответом на 
возрастающую потребность в портатив-
ной электронной технике потребитель-
ского назначения (в т.ч. смарт-фоны и 
КПК) с расширенными функциональ-
ными возможностями навигации. Сре-
ди этих возможностей – автоматическая 
ориентация карты, индикация направ-
ления (в т.ч. при отсутствии движения), 
сигнализация о наличии интересующих 
объектов (театры, рестораны, станции 
метро и т.п.) в выбранном направле-
нии и сохранение функций навигации 
в условиях неустойчивого или полного 
отсутствия приема сигналов от систем 
глобального спутникового позициони-
рования.

Структура модуля LSM303DLH по-
казана на рисунке 3. Каналы измерения 
напряженности магнитного поля пред-
усматривают работу в одном из семи 
программно-выбираемых диапазонов от 
±(0,13...0,81) мТл (ведется разработка 
модуля для диапазона до 2 мТл). В свою 
очередь каналы измерения линейных 
ускорений поддерживают работу в 
одном из трех программно-задаваемых 

диапазонов ±2/±4/±8g. Вывод резуль-
татов измерений организован в цифро-
вом виде (16-битный формат). Для это-
го в модуль интегрированы АЦП и два 
независимых последовательных интер-
фейса I2C (поддерживаются скоростные 
режимы 100 и 400 кГц). Модуль пред-
усматривает возможность раздельного 
перевода в экономичный режим работы 
трактов магнетометра и акселерометра 
и генерации двух сигналов прерывания 
с гибкой программируемой настройкой. 

Рис. 1. Структурная схема и расположение выводов гироскопов l3G4200D/DH

Рис. 2. Система автоматического мониторинга 
транспорта



НОВОСТИ ЭЛЕКТРОНИКИ № 6, 2010

ОБЗОРЫ

26

Данные прерывания позволяют активи-
зировать управляющий процессор в слу-
чае обнаружения движения и свободного 
падения. Функциональные возможности 
модуля завершают функции тестирова-
ния, которые могут быть инициирова-
ны по запросу пользователя раздельно 
для трактов магнетометра и акселероме-
тра. Столь внушительные возможности 
модуля реализованы в рамках чрезвы-
чайно компактного 28-выводного кор-
пуса LGA с размерами 5х5х1 мм. Его 
рабочие характеристики гарантированы 
для диапазонов напряжения питания 
2,5...3,3 В и температур -30...85°C.

Несмотря на первоочередную ори-
ентацию на потребительские приме-
нения, модуль LSM303DLH может с 
успехом использоваться в разнообраз-
ных промышленных приложениях: в 
системах навигации любых транспорт-
ных средств; охранных системах и си-
стемах безопасности; строительном обо-
рудовании; системах позиционирования 
антенн; автоматических системах вы-
равнивания; в буровом оборудовании; 
в системах управления автомобильным 
движением (в т.ч. в парковочных систе-
мах); в метеорологическом и геофизи-
ческом оборудовании (в т.ч. при мони-
торинге сейсмоактивности), а также в 
робототехнике.

Модуль LSM303DLH доступен в 
предустановленном виде в составе де-
монстрационной платы iNEMO вто-
рого поколения (код заказа STEVAL-
MKI062V2). Данная плата может 
выступать в роли завершенной плат-
формы для контроля инерциальной 
системы с 10 степенями свободы. Для 
этой цели на ней установлены двухосе-
вой гироскоп (roll, pitch) LPR430AL, 
одноосевой гироскоп (yaw) LY330ALH, 
рассмотренный только что модуль трех-
осевого магнетометра и трехосевого ак-
селерометра LSM303DLH, датчик дав-
ления LPS001DL (300...1100 мбар) с 
функцией барометра и датчик темпера-
туры STLM75 (измеряемый диапазон 
-55...125°C). Логику работы платы опре-
деляет установленный на ней 32-бит-
ный микроконтроллер STM32F103RE 
(256...512 кбайт flash-памяти, модули 
USB и CAN, 11 таймеров, три АЦП и 
13 коммуникационных интерфейсов). 
Для взаимодействия с внешним миром 
предусмотрены разъем для подключе-
ния устройств беспроводной связи, пор-
ты COM и USB 2.0 FS. Кроме того, на 
плате предусмотрены разъем для уста-
новки карт памяти MicroSD™, програм-
мируемые светодиод и кнопка. Приме-
чательно, что при столь внушительных 
возможностях платы ее размеры чрез-

Рис. 3. Структурная схема модуля цифрового компаса lSM303DlH

вычайно малы и составляют 4х4 см. 
В связи с этим она идеальна для исполь-
зования в качестве завершенного реше-
ния для интеграции в разнообразные 
системы, в т.ч. системы виртуальной ре-
альности, дополненной реальности [4], 
стабилизации изображений, человеко-
машинных интерфейсов и робототехни-
ческие системы.

Заключение
Согласно прогнозам iSuppli, в бли-

жайшие годы будет иметь место суще-
ственный рост объемов продаж элек-
троники потребительского назначения 
с улучшенными функциями навигации 
на местности и улучшенными до инту-
итивного уровня возможностями поль-
зовательского интерфейса. В частности, 
среднегодовой темп роста объемов про-
даж только одних мобильных телефо-
нов со встроенным цифровым компасом 
составит порядка 130% и сохранится 
вплоть до 2013 г. Новая продукция STM 
имеет все шансы для успешной конку-
ренции на массовом рынке потребитель-
ской электроники. Помимо отличных 
рабочих характеристик этому способ-
ствует учет всех требований исполь-
зования в портативной электронике, 
включая очень малые размеры корпуса, 
простоту схемы включения, низковольт-
ное питание, малый потребляемый ток в 
активном режиме работы и возможность 
перевода в экономичный режим работы. 
Благодаря гарантированности рабочих 
характеристик в пределах широкого ди-
апазона температур (-30/40...85°С) но-
вая продукция STM также с успехом 
может применяться в разнообразных 
промышленных применениях.

Более детальная информация по ги-
роскопам и прочим МЭМС-датчикам 
STM доступна по ссылке www.st.com/
mems.
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К
омпания STMicroelectronics 
выпускает микросхемы для 
создания неизолированных 
DC/DC-преобразователей с 

высокими качественными показателя-
ми, требующие небольшого количества 
внешних компонентов.

Постоянное развитие ИС для DC/
DC-преобразователей характеризуется 
следующими факторами: 

• повышением рабочих частот пре-
образования (максимальная часто-
та преобразования для микросхем 
STMicroelectronics составляет 1,7 МГц), 
что позволяет резко уменьшить разме-
ры внешних компонентов и минимизи-
ровать площадь печатной платы;

• уменьшением размеров корпусов 
микросхем благодаря высоким частотам 
преобразования (корпус DFN6D имеет 
размеры всего 3х3 мм); 

• повышением удельной плотности 
выходного тока (корпус DFN6D обеспе-
чивает выходной ток до 2,0 А; корпуса 
DFN8 и PowerSO-8 могут работать при 
токах до 3,0 А);

• повышением КПД и снижением 
потребляемой мощности при отключен-
ном состоянии, что особенно важно для 
приборов с автономным питанием.

Компания STM разделяет свои ми-
кросхемы для неизолированных DC/
DC-преобразователей на две группы. 
Первая группа имеет рабочую часто-
ту до 1 МГц (параметры сведены в та-
блицу 1), вторая группа – с частотой 
преобразования 1,5 и 1,7 МГц (параме-
тры см. в таблице 2). Во вторую груп-
пу добавлены также и микросхемы се-
рии ST1S10 с номинальной частотой 
преобразования 0,9 МГц (максималь-
ная частота преобразования для этих 
микросхем может достигать 1,2 МГц). 
Микросхемы серии ST1S10 могут рабо-
тать при синхронизации от внешнего ге-
нератора в диапазоне частот от 400 кГц 
до 1,2 МГц.

Основная часть микросхем для DC/
DC-преобразователей из таблицы 1 име-
ет частоту преобразования до 300 кГц. 
На таких частотах облегчается выбор 
индуктивностей на выходе DC/DC, т. 
к. для рабочих частот микросхем из та-
блицы 2 (1,5 и 1,7 МГц) на частотные 
характеристики индуктивностей необхо-
димо обращать особое внимание. На ри-
сунках 1 и 2 в качестве примеров при-
ведены рекомендуемые производителем 
схемы включения микросхем L5973D 
(выходной ток до 2,0 А при частоте пре-
образования 250 кГц) и ST1S06 (выход-
ной ток до 1,5 А при частоте преобразо-
вания 1,5 МГц).

Из рисунков 1 и 2 видно, что микро-
схемы с относительно низкими часто-
тами преобразования по современным 
меркам требуют большего количества 
внешних электронных компонентов, 
имеющих увеличенные размеры по 
сравнению с компонентами преобразо-
вателей, работающих на частотах более 
1 МГц. Микросхемы для DC/DC из та-
блицы 2 обеспечивают гораздо меньшие 
размеры печатной платы, но необходи-
мо более внимательно относиться к раз-
водке проводников для уменьшения из-
лучаемых электромагнитных помех.

Некоторые микросхемы позволяют 
управлять включением и выключением 
конвертеров благодаря наличию вхо-
да INHIBIT. Пример включения таких 
микросхем приведен на рис. 3. ST1S09 
(без входа INHIBIT) и ST1S09I (с вхо-
дом INHIBIT). В нижней части этого 
рисунка приведены рекомендуемые зна-
чения номиналов резисторов R1 и R2 
для формирования выходных напряже-
ний 1,2 и 3,3 В.

При наличии на входе управления 
VINH высокого уровня напряжения 
(более 1,3 В) микросхема ST1S09I нахо-
дится в активном состоянии; при напря-
жении на этом входе менее 1,4 В DC/
DC-преобразователь отключается (соб-
ственное потребление при этом состав-
ляет менее 1 мкА). Вариант микросхе-
мы без входа управления на выводе 6 
вместо входа VINH имеет выход «PG = 
Power Good» (питание в норме). Фор-
мирование сигнала «Power Good» про-
иллюстрировано на рис. 4. Когда на вхо-
де «FB» (FeedBack или вход обратной 
связи) достигается значение 0,92хVFB, 
происходит переключение компаратора, 
и на выходе PG формируется высокий 
уровень напряжения, информирующий 
о том, что выходное напряжение нахо-
дится в допустимых пределах.

Эффективность преобразования на 
примере микросхем ST1S09 и ST1S09I

Эффективность понижающего DC/
DC-преобразователя сильно зависит от 

В статье рассматриваются основные характеристики микросхем неизоли-
рованных DC/DC-преобразователей компании STMicroelectronics, отли-
чающихся простотой, высокими эксплуатационными характеристиками и за-
служенной популярностью у разработчиков электронной техники.

МикросхеМы 
для DC/DC-преобразователей 
от STMiCroeleCTroniCS

Евгений Звонарев (КОМПЭЛ)

Рис. 1. схема включения l5973D (частота преобразования 250 кГц)
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параметров интегрированных в микро-
схемы транзисторов с изолированным за-
твором (MOSFET), выполняющих роль 
ключа. Одна из проблем высокочастот-
ных преобразователей связана с током 
заряда затвора транзистора при управле-
нии им с помощью ШИМ-контроллера. 
Потери в этом случае практически не за-
висят от тока в нагрузке. Вторая пробле-
ма, снижающая КПД, – рассеиваемая в 
транзисторе мощность во время переклю-
чения из одного состояния в другое (в 
эти промежутки времени транзистор ра-
ботает в линейном режиме). Уменьшить 
потери можно, обеспечив более крутые 
фронты переключения, но это повыша-

Таблица 1. Микросхемы STMicroelectronics для DC/DC-преобразователей с частотой преобразования до 1 МГц

Наименование Топология Vвх., В Vвых., В Iвых., А Частота 
преобразования, МГц

Вход 
отключения Корпус

L296 Step-down 9...46 5,1...40 4 до 200 Есть MULTIWATT-15
L4960 Step-down 9...46 5,1...40 2,5 до 200 Нет HEPTAWATT-7

L4962 Step-down 9...46 5,1...40 1,5 до 200 Есть
HEPTAWATT-8, DIP-

16
L4963 Step-down 9...46 5,1...40 1,5 42...83 Нет DIP-18, SO-20
L4970A Step-down 12...50 5,1...50 10 до 500 Нет MULTIWATT-15
L4971 Step-down 8...55 3,3...50 1,5 до 300 Есть DIP-8, SO-16W
L4972A Step-down 12...50 5,1...40 2 до 200 Нет DIP-20, SO-20
L4973D3.3 Step-down 8...55 0,5...50 3,5 до 300 Есть DIP-8, SO-16W
L4973D5.1 Step-down 8...55 5,1...50 3,5 до 300 Есть DIP-8, SO-16W
L4974A Step-down 12...50 5,1...40 3,5 до 200 Нет MULTIWATT-15
L4975A Step-down 12...50 5,1...40 5 до 500 Нет MULTIWATT-15
L4976 Step-down 8...55 0,5...50 1 до 300 Есть DIP-8, SO-16W
L4977A Step-down 12...50 5,1...40 7 до 500 Нет MULTIWATT-15
L4978 Step-down 8...55 3,3...50 2 до 300 Есть DIP-8, SO-16W
L5970AD Step-down 4,4...36 0,5...35 1 500 Есть SO-8
L5970D Step-down 4,4...36 0,5...35 1 250 Есть SO-8
L5972D Step-down 4,4...36 1,23...35 1,5 250 Нет SO-8
L5973AD Step-down 4,4...36 0,5...35 1,5 500 Есть HSOP-8
L5973D Step-down 4,4...36 0,5...35 2 250 Есть HSOP-8
L5987A Step-down 2,9...18 0,6...Vвх. 3 250...1000 Есть HSOP-8
L6902D Step-down 8...36 0,5...34 1 250 Нет SO-8
L6920D Step-up 0,6...5,5 2...5,2 1 до 1000 Есть TSSOP-8
L6920DB Step-up 0,6...5,5 1,8...5,2 0,8 до 1000 Есть miniSO-8

Таблица 2. Микросхемы для понижающих DC/DC-преобразователей с частотой преобразования от 0,9 до 1,7 МГц

Серия Наименование Iвых., А Vвх.,В Vвых., В
Частота 

преобразования, 
МГц

Вход 
отключения Корпус

ST1S03 ST1S03PUR

1,5

3...16 0,8...12 1,5 Нет DFN6D (3х3 мм)

ST1S03A
ST1S03AIPUR

3…5.5 0,8...5.5
1,5 Есть

DFN6D (3х3 мм)
ST1S03APUR 1,5 Нет

ST1S06 ST1S06PUR
2,7…6 0,8...5.5

1,5 Есть
DFN6D (3х3 мм)

ST1S06A ST1S06APUR 1,5 Нет
ST1S06xx12 ST1S06PU12R

2,7...6
1,2 1,5 Есть

DFN6D (3x3 мм)
ST1S06xx33 ST1S06PU33R 3,3 1,5 Есть

ST1S09
ST1S09IPUR

2,0 2,7...5,5 0,8...5
1,5 Есть

DFN6D (3х3 мм)
ST1S09PUR 1,5 Нет

ST1S10
ST1S10PHR

3,0 2,5...18 0,8...0,85Vвх. 0,9 (0,4...1,2)* Есть
PowerSO-8

ST1S10PUR DFN8 (4x4 мм)
ST1S12xx ST1S12GR

0,7 2,5...5,5
1,2...5

1,7 Есть TSOT23-5LST1S12xx12 ST1S12G12R 1,2
ST1S12xx18 ST1S12G18R 1,8
* – в скобках указан диапазон частот преобразования при синхронизации от внешнего генератора.

Рис. 2. схема включения ST1S06 (ток до 1,5 а, частота преобразования 1,5 МГц)
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Таблица 3. близкие замены микросхем для DC/DC-преобразователей от других производителей

Производитель Наименование Iвых 
макс., А

Частота 
преобразования, 

МГц
Power Good Совместимость 

по выводам Корпус

STMicroelectronics
ST1S09PUR

2 1,5
Есть Есть

DFN3x3-6
ST1S09IPUR Нет Есть

Fairchild Semiconductor FAN2013MPX 2 1,3 Нет Есть DFN3x3-6

Таблица 4. близкие замены микросхем ST1S10Pxr для понижающих DC/DC-преобразователей от других производителей

Производитель Наименование Iвых 
макс., А

Синхронное 
выпрямление Компенсация Мягкий запуск

Совмести- 
мость 

по выводам
Корпус

STMicroelectronics
ST1S10PHR

3 Есть Внутренняя Внутренний –
PowerSO-8

ST1S10PUR DFN8 (4x4 мм)

Monolithic Power 
Systems MP2307/MP1583 3 Есть/Нет Внешняя Внешний Нет SO8-EP

Alpha & Omega 
Semiconductor AOZ1013 3 Нет Внешняя Внутренний Нет SO8

Semtech SC4521 3 Нет Внешняя Внешний Нет SO8-EP

AnaChip AP1510 3 Нет Внутренняя Внутренний Нет SO8

ет электромагнитные шумы и помехи по 
цепям питания. Еще одна причина сни-
жения КПД преобразователя – наличие 
активного сопротивления «сток – исток» 
(Rdson). В правильно спроектированной 
схеме КПД достигает максимального зна-
чения при равенстве статических (омиче-
ских) и динамических потерь. Следует 
учесть, что выходной выпрямительный 
диод также вносит свою долю динами-
ческих и статических потерь. Некоррек-
тно выбранная индуктивность на выходе 
DC/DC-преобразователя может допол-
нительно существенно снизить эффек-
тивность преобразования, что заставляет 
помнить и об ее высокочастотных свой-
ствах. В самом плохом случае на высо-
ких частотах преобразования выходной 
дроссель может потерять свои индуктив-
ные свойства, и преобразователь просто 
не будет работать.

Компания STMicroelectronics уже 
много лет выпускает мощные полевые 
транзисторы и диоды с очень высокими 
динамическими и статическими харак-
теристиками. Обладание отлаженной 
технологией производства транзисторов 
MOSFET позволяет компании интегри-
ровать свои полевые транзисторы в ми-
кросхемы для DC/DC-преобразователей 
и достигать высоких значений  КПД 
преобразования.

На рис. 5 (а, б, в) в качестве примера 
приведены типовые зависимости эффек-
тивности преобразования от некоторых 
параметров при разных условиях работы. 
Графики зависимости КПД от величины 
выходного тока достигают максимальных 
значений около 95% при токе 0,5 А. Да-
лее спад этих характеристик довольно 
пологий, что характеризует лишь неболь-
шое увеличение потерь при росте выход-
ного тока до максимального значения.

На рис. 5б показаны зависимости 
КПД от уровня выходного напряжения Рис. 3. отличия схем включения ST1S09 (без входа отключения) и ST1S09i (с входом отключения)
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Таблица 5. близкие замены микросхем ST1S12 для понижающих DC/DC-преобразователей от других производителей

Производитель Наименование Iвых 
(макс.), мА

Частота 
преобразова-

ния, МГц 
Vвх (макс.), В Вход 

отключения

Совмести- 
мость 

по выводам
Корпус

STMicroelectronics ST1S12 700 1,7 5,5 есть – TSOT23-5L

Monolithic Power 
Systems MP2104 600 1,7 6 есть есть TSOT23-5L

National 
Semiconductor

LM3674 600 2 5,5 есть нет SOT23-5L

LM3671 600 2 5,5 есть нет SOT23-5L

DC/DC-преобразователей на микросхе-
мах ST1S09 и ST1S09I. С ростом выход-
ного напряжения КПД возрастает. Это 
объясняется тем, что падение напряже-
ния на транзисторах выходного каска-
да практически не зависит от выходного 
напряжения при неизменном выходном 
токе, поэтому с ростом выходного на-
пряжения процент вносимых потерь бу-
дет уменьшаться.

На рис. 5в приведены зависимости 
КПД от величины индуктивности на 
выходе. В диапазоне от 2 до 10 мкГн 
эффективность преобразования практи-
чески не изменяется, что позволяет вы-
бирать величину индуктивности из ши-
рокого диапазона номиналов. Конечно, 
нужно стремиться к максимально воз-
можному уровню индуктивности для 
обеспечения лучшей фильтрации напря-
жения пульсаций выходного тока. По-
нятно, что с ростом значений выходного 
тока КПД уменьшается. Это объясняет-
ся ростом потерь в выходных каскадах 
DC/DC-преобразователей.

Сравнение с микросхемами других 
производителей 

В таблицах 3, 4 и 5 приведены па-
раметры близких по функциональному 
значению микросхем от других произ-
водителей.

Из таблицы 3 видно, что 
FAN2013MPX – это полный аналог для 
микросхемы ST1S09IPUR, но у компа-
нии STMicroelectronics дополнительно в 
этой серии есть микросхема ST1S09PUR 
с наличием выхода «Power Good», что 
расширяет выбор разработчика.

В таблице 4 приведены функцио-
нальные замены (нет совместимости по 
выводам) от других производителей для 
микросхем ST1S10. Основное преиму-
щество микросхем ST1S10 – наличие 
синхронного выпрямления в выходных 
каскадах, что обеспечивает более высо-
кий КПД преобразования. Кроме того, 
корпус DFN8 (4х4 мм) имеет мень-
шие размеры по сравнению с корпуса-
ми функционально близких микросхем 
других производителей. Внутренняя 
схема компенсации позволяет сократить 
количество внешних компонентов об-
вязки микросхем.

В таблице 5 показаны возмож-
ные замены для микросхем ST1S12. 
Основное преимущество микросхем 
ST1S12 – большее значение максималь-

Рис. 4. Формирование сигнала «Power Good» на выходе PG микросхемы ST1S09

Рис. 5а. зависимости кпд для серии ST1S09 от выходного тока

Рис. 5б. зависимости кпд для серии ST1S09 от выходного напряжения
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Получение технической информации, 
заказ образцов, поставка – 

e-mail: analog.vesti@compel.ru

но допустимого выходного тока: до 700 
мА. Микросхема MP2104 фирмы MPS 
совместима по выводам с микросхе-
мой ST1S12. Микросхемы LM3674 и 
LM3671 можно рассматривать только в 
качестве близкой функциональной за-
мены для ST1S112 из-за отсутствия со-
вместимости по выводам.

Выбор микросхем для 
DC/DC-преобразователей на сайте

Для быстрого поиска электронных 
компонентов по известным параметрам 
удобнее всего воспользоваться сайтом 
www.catalog.compel.ru. Для пара-
метрического поиска на этом сайте на-
стоятельно рекомендуется установить 
и использовать бесплатную программу 
для просмотра сайтов (браузер) «Google 
Chrome». Работа в этом браузере уско-
ряет поиск в несколько раз. Микросхе-
мы для DC/DC-преобразователей ком-
пании STMicroelectronics можно найти 
на сайте по следующему пути: «Управ-
ление питанием» → «ИМС для DC/
DC» → «Регуляторы (+ключ)». Далее 
можно выбрать бренд «ST» и активиро-
вать фильтр «Склад» для выбора толь-
ко тех компонентов, которые имеются 
на складе. Результат этих действий по-
казан на рис. 6. Можно сделать более 
конкретную выборку по требуемым па-
раметрам, применяя другие фильтры.

Заключение
Особенно важен правильный 

выбор микросхем для DC/DC-
преобразователей в приборах с автоном-
ными источниками питания. В некото-
рых случаях выбор подходящей схемы 
питания может оказаться трудной зада-
чей, но, уделив достаточно времени про-
работке и выбору схемы электропитания 
устройства, можно добиться определен-
ного преимущества над конкурентами 
за счет более компактного и недорого-
го решения с более высокой эффектив-

ностью преобразования электрической 
энергии. Микросхемы для DC/DC-
преобразователей STMicroelectronics 
облегчают выбор и позволяют реализо-
вать заложенные в них преимущества 
при создании конкурентоспособных 
схем электропитания.

Рис. 5в. зависимости кпд для серии ST1S09 от индуктивности
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М
ощные полевые MOSFET-
транзисторы и биполяр-
ные транзисторы с изо-
лированным затвором 

(IGBT-транзисторы) являются базовы-
ми элементами современной силовой 
электроники и используются в качестве 
элементов коммутации больших токов и 
напряжений. Однако для согласования 
низковольтных логических управляю-
щих сигналов с уровнями управления 
затвора MOSFET- и IGBT-транзисторов 
требуются промежуточные устройства 
согласования – высоковольтные драй-
веры (в дальнейшем, для краткости, 
под «высоковольтными драйверами» бу-
дем понимать «высоковольтные драйве-
ры MOSFET- и IGBT-транзисторов»).

В большинстве случаев использует-
ся следующая классификация высоко-
вольтных драйверов:

• Независимые драйверы верхнего 
и драйверы нижнего плеча полумоста, 
интегрированные в одной микросхеме 
(High and Low Side Driver);

• Драйверы верхнего и драйверы 
нижнего плеча, включенные по схеме 
полумоста (Half-Bridge Driver);

• Драйверы верхнего плеча (High 
Side Driver);

• Драйверы нижнего плеча (Low 
Side Driver).

На рис. 1 показаны соответствую-
щие этим типам драйверов схемы управ-
ления.

В первом случае (рис. 1а) управле-
ние двумя независимыми нагрузками 
осуществляется от единых управляю-
щих сигналов. Нагрузки, соответствен-
но, включаются между истоком нижнего 
транзистора и шиной высоковольтно-
го питания (драйвер нижнего плеча), 
а также между стоком верхнего тран-
зистора и землей (драйвер верхнего 
плеча). Так называемые средние точ-
ки (сток верхнего транзистора и исток 

нижнего транзистора) не соединены 
между собой.

Во втором случае (рис. 1б) средние 
точки соединены. Причем нагрузка мо-
жет быть включена как на верхнее, так и 
на нижнее плечо, но подключена к сред-
ней точке аналогично полумостовой схе-
ме (т.н. полная мостовая схема). Строго 
говоря, в схеме 1а ничто не мешает сое-
динить средние точки. Но в этом случае 
при определенной комбинации входных 
сигналов возможно одновременное от-
крытие сразу двух транзисторов и, соот-
ветственно, протекание чрезмерно боль-
шого тока от высоковольтной шины на 
землю, что приведет к выходу из строя 
одного или сразу обоих транзисторов. 
Исключение подобной ситуации в дан-
ной схеме является заботой разработ-
чика. В полумостовых драйверах (схе-

ма 1б) подобная ситуация исключается 
на уровне внутренней логики управле-
ния микросхемы.

В третьем случае (1в) нагрузка вклю-
чается между стоком верхнего транзи-
стора и землей, а в четвертом (1г) – 
между истоком нижнего транзистора и 
шиной высоковольтного питания, т.е. 
отдельно реализованы две «половинки» 
схемы 1а.

Компания STMicroelectronics в по-
следние годы ориентируется (в нише 
высоковольтных драйверов) только 
на драйверы первых двух типов (се-
мейства L638x и L639x, которые бу-
дут рассмотрены ниже). Однако более 
ранние разработки содержат микро-
схемы драйверов, управляющих вклю-
чением или выключением одиночного 
MOSFET- или IGBT-транзистора (ка-
тегория «Single» в терминах компании 
STMicroelectronics). При определен-
ной схеме включения данные драйверы 
могут управлять нагрузкой как верх-
него, так и нижнего плеча. Отметим 
также микросхему TD310 – три неза-
висимых одиночных драйвера в одном 

В линейке аналоговых и смешанных интегральных схем, выпускаемых ком-
панией STMicroelectronics, важное место занимают драйверы MOSFET- и 
IGBT-транзисторов. В статье рассматриваются высоковольтные драйве-
ры компании STM. Основное внимание уделяется современным сериям высо-
ковольтных драйверов L638x и L639x.

Современные 
выСоковольтные драйверы 
MOSFET- и IGBT-транзиСторов

Андрей Никитин (г. Минск)

Рис. 1. Упрощенные схемы управления MOSFET- и IGBT-транзисторами
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корпусе. Такое решение будет эффек-
тивным при управлении трехфазной на-
грузкой. Данную микросхему компания 
STMicroelectronics относит к драйверам 
категории «Multiple».

Семейство высоковольтных драйверов 
L368x

В таблице 1 приводятся состав и па-
раметры микросхем семейства L368x. 
Микросхемы данного семейства вклю-
чают в себя как независимые драйверы 
верхнего и нижнего плеча (H&L), так и 
драйверы полумостовой схемы (HB).

Поясним некоторые параметры:
VOFFSET – максимально возможное 

напряжение между истоком верхнего 
транзистора и землей;

IO+ (IO-) – максимальный выходной 
ток при открытом верхнем (нижнем) 
транзисторе выходного каскада микро-
схемы;

TON (TOFF) – задержка распростране-
ния сигнала от входов HIN и LIN до 
выходов HO и LO при включении (вы-
ключении);

TDT – время паузы – параметр, име-
ющий отношение к драйверам полу-
мостовой схемы. При смене активных 
состояний логическая схема принуди-
тельно вводит паузы, позволяющие 
избегать включения верхнего и ниж-
него плеча одновременно. Например, 
если выключается нижнее плечо, то 
какое-то время оба плеча выключены и 
только потом включается верхнее. И, 
наоборот, если выключается верхнее 
плечо, то какое-то время оба плеча вы-
ключены и затем включается нижнее. 
Это время может быть либо фикси-
рованным (как в L6388E), либо зада-
ваться путем выбора номинала соответ-
ствующего внешнего резистора (как в 
L6384E).

Управление. Микросхемы незави-
симых драйверов верхнего и нижнего 
плеча управляются по входам HIN и 
LIN. Причем высокий уровень логиче-
ского сигнала включает, соответствен-
но, верхнее или нижнее плечо драйве-
ра. В микросхеме L6386E помимо этого 
используется дополнительный вход SD, 
отключающий оба плеча независимо от 
состояния на входах HIN и LIN.

В микросхеме L6384E применяются 
сигналы SD и IN. Сигнал SD отключает 
оба плеча независимо от состояния на 
входе IN. Сигнал IN = 1 эквивалентен 
комбинации сигналов {HIN = 1, LIN = 
0} и, наоборот, IN = 0 эквивалентен ком-

бинации сигналов {HIN = 0, LIN = 1}. 
Таким образом, одновременное включе-
ние транзисторов верхнего и нижнего 
плеча невозможно в принципе.

В микросхеме L6388E управление 
осуществляется по входам HIN и LIN, 
поэтому принципиально возможно по-
дать на входы комбинацию {HIN = 1, 
LIN = 1}, однако внутренняя логиче-
ская схема преобразует ее в комбина-
цию {HIN = 0, LIN = 0}, исключив, та-
ким образом, одновременное включение 
обоих транзисторов.

Что касается параметров, начнем с 
микросхем типа H&L.

Значение VOFFSET, равное 600 Вольт, 
является в каком-то смысле стандартом 
для микросхем данного класса. 

Значение выходного тока IO+ (IO-), 
равное 400/650 мА, является показате-
лем средним, ориентированным на ти-
повые транзисторы общего назначения. 
Если сравнивать с микросхемами семей-
ства IRS (поколение G5 HVIC), то ком-
пания International Rectifier предлагает, 
главным образом, микросхемы с пара-
метром 290/600 мА. Однако в линейке 
International Rectifier есть также модели 
с параметрами 2500/2500 мА (IRS2113) 
и несколько меньшим быстродействием 
или микросхемы с выходными токами 
до 4000/4000 мА (IRS2186). Правда, 
в этом случае время переключения по 
сравнению с L6385E увеличивается до 
значения 170/170 нс.

Время переключения. Значения 
TON (TOFF), равные 110/105 нс (для 
L6385E), превышают аналогичные зна-
чения микросхем семейства IRS (пусть и 
не очень значительно). Лучших показа-
телей (60/60 нс) компания International 
Rectifier добилась в модели IRS2011, но 
за счет снижения напряжения VOFFSET 
до 200 В.

Однако отметим, что компания 
STMicroelectronics предлагает драйве-
ры, в которых общий провод входного 
(низковольтного) и выходного (высоко-
вольтного) каскадов – единый. Компа-
ния International Rectifier, помимо ми-
кросхем с аналогичной архитектурой, 
предлагает драйверы с раздельными об-
щими шинами для входного и выходно-
го каскадов.

Сравнивая параметры драйвера по-
лумостовой схемы L6384E с изделиями 
International Rectifier, можно сделать вы-
вод, что он уступает (и по выходным то-
кам, и по быстродействию) только модели 
IRS21834, в которой реализована входная 
логика HIN/-LIN. Если критичной явля-
ется входная логика IN/-SD, то драйвер 
L6384E превосходит по своим параметрам 
изделия International Rectifier.

Более подробно рассмотрим микро-
схему драйвера L6385E, структура и 
схема включения которой приведена на 
рис. 2.

Микросхема содержит два независи-
мых драйвера верхнего (выход HVG) и 
нижнего плеча (выход LVG). Реализа-
ция драйвера нижнего плеча достаточ-
но тривиальна, поскольку потенциал на 
выводе GND постоянен и, следователь-
но, задача состоит в преобразовании 
входного низковольтного логическо-
го сигнала LIN до уровня напряжения 
на выходе LVG, необходимого для от-
крытия транзистора нижнего плеча. 
В верхнем плече потенциал на выводе 
OUT изменяется в зависимости от со-
стояния нижнего транзистора. Суще-
ствуют различные схемотехнические 
решения, применяемые для построения 
каскада верхнего плеча. В данном слу-
чае применяется относительно простая 
и недорогая бутстрепная схема управле-
ния (схема с «плавающим» источником 

Таблица 1. Параметры драйверов семейства L638x

Наименование Voffcet, В Io+, мА Io-, мА Ton, нс Toff, нс Tdt, нс Тип Управление
L6384E 600 400 650 200 250 Prog. HB IN/-SD

L6385E 600 400 650 110 105 H&L HIN/LIN

L6386E 600 400 650 110 150 H&L HIN/LIN/-SD

L6387E 600 400 650 110 105 H&L HIN/LIN

L6388E 600 200 350 750 250 320 HB HIN/LIN

Рис. 2. Структура и схема включения L6385E
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питания). В такой схеме длительность 
управляющего импульса ограничена ве-
личиной бутстрепной емкости. Кроме 
того, необходимо обеспечить условия 
для ее постоянного заряда с помощью 
высоковольтного быстродействующего 
каскада сдвига уровня. Этот каскад обе-
спечивает преобразование логических 
сигналов до уровней, необходимых для 
устойчивой работы схемы управления 
транзистора верхнего плеча.

При падении напряжения управле-
ния ниже определенного предела вы-
ходные транзисторы могут перейти в 
линейный режим работы, что, в свою 
очередь, приведет к перегреву кристал-
ла. Для предотвращения этого долж-
ны использоваться схемы контроля на-

пряжения (UVLO – Under Voltage 
LockOut) и для верхнего (контроль по-
тенциала VBOOT), и для нижнего (кон-
троль VCC) плеча.

Для современных высоковольтных 
драйверов характерна тенденция инте-
грировать бутстрепный диод в корпус 
интегральной схемы. Благодаря этому 
отпадает необходимость в применении 
внешнего диода, который является до-
статочно громоздким по сравнению с са-
мой микросхемой драйвера. Встроенный 
бутстрепный диод (точнее, бутстрепная 
схема) применен не только в драйвере 
L6385E, но и во всех остальных микро-
схемах этого семейства.

Микросхема L6386E является вари-
антом L6385E с дополнительными функ-

циями. Ее структура и схема включения 
приведены на рис. 3.

Основные отличия L6386E от 
L6385E. Во-первых, добавлен дополни-
тельный вход SD, низкий уровень сиг-
нала на котором выключает оба транзи-
стора независимо от состояния входов 
HIN и LIN. Часто используется как сиг-
нал аварийного отключения, не связан-
ный со схемой формирования входных 
управляющих сигналов. Во-вторых, до-
бавлен каскад контроля тока, протекаю-
щего через транзистор нижнего каскада. 
Сравнивая с предыдущей схемой, ви-
дим, что сток транзистора нижнего пле-
ча подключен к земле не непосредствен-
но, а через токовый резистор (токовый 
датчик). Если падение напряжения 
на нем превышает пороговое значение 
VREF, то на выходе DIAG формируется 
низкий уровень. Отметим, что данное 
состояние не влияет на работу схемы, а 
является только индикатором.

Несколько слов о применении микро-
схем семейства L638x. Ограниченный 
объем статьи не позволяет рассмотреть 
примеры применения, однако в доку-
менте «L638xE Application Guide» ком-
пании STMicroelectronics [1] приведены 
примеры схемы управления трехфазным 
двигателем, схемы балласта люминес-
центной лампы с диммированием, DC/
DC-преобразователей с различной архи-
тектурой и ряд других. Также приведе-
ны схемы демонстрационных плат для 
всех микросхем данного семейства (в 
том числе и топология печатных плат).

Подводя итог анализа семейства 
L638x, отметим: не обладая уникальны-
ми характеристиками по каким-то от-
дельным параметрам, драйверы данного 
семейства относятся к одним из лучших 
в отрасли как по совокупности параме-
тров, так и по примененным техниче-
ским решениям.

Семейство высоковольтных драйверов 
полумостовой схемы L639x

На первый взгляд, микросхемы это-
го семейства можно считать развитием 
микросхемы L6384E. Однако анали-
зируя функциональные возможности 
драйверов семейства L639x, признать 
L6384E в качестве прототипа весьма 
сложно (разве что за отсутствием дру-
гих драйверов полумоста в линейке 
STMicroelectronics). В таблице 2 приво-
дятся состав и параметры микросхем се-
мейства L639x.

Основная особенность микросхем 
данного семейства – наличие дополни-
тельных встроенных элементов: опе-

Таблица 2. Параметры драйверов семейства L639x

Наименование Voffcet, В Io+, мА Io-, мА Ton, нс Toff, нс Tdt, мкс Тип Smart SD ОУ Комп. Управление
L6390 600 270 430 125 125 0,15...2,7 HB есть есть есть HIN/-LIN/-SD

L6392 600 270 430 125 125 0,15...2,7 HB есть HIN/-LIN/-SD

L3693 600 270 430 125 125 0,15...2,7 HB есть PH/-BR/-SD

Рис. 3. Структура и схема включения L6386E

Рис. 4. Структура и схема включения L6390
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рационного усилителя или компара-
тора (для L6390 – и того, и другого). 
На рис. 4 показана структура и схема 
включения микросхемы L6390.

Какие преимущества дают дополни-
тельные элементы в практических при-
ложениях? Операционные усилители 
(в L6390 и L6392) предназначены для 
измерения тока, протекающего через 
нагрузку. Причем, поскольку доступны 
оба вывода (OP+ и OP-), возникает воз-
можность формировать на соответству-
ющем выходе микросхемы и абсолютное 
значение, и отклонение от некоторого 
опорного напряжения (соответствующе-
го, например, максимально допустимо-
му значению). В драйвере L6390 ком-
паратор выполняет вполне конкретную 
функцию «интеллектуального отключе-
ния» (Smart Shutdown) – т.е. при пре-
вышении максимально допустимого тока 
в нагрузке компаратор начинает влиять 
на логику работы драйвера и обеспечи-
вает плавное отключение нагрузки. Ско-
рость отключения задается RC-цепью, 
подключенной к выводу SD/OD. При-
чем, поскольку данный вывод является 
двунаправленным, то он может являть-
ся как выходом индикации ошибки для 
управляющего микроконтроллера, так 
и входом для принудительного отклю-
чения.

Все микросхемы содержат логику 
защиты от одновременного открытия 
транзисторов верхнего и нижнего плеча 
и, соответственно, формирования паузы 
при изменении состояния выхода. Вре-
мя паузы TDT для всех микросхем семей-
ства программируемое и определяется 
номиналом резистора, подключенного к 
выводу DT.

Логика управления в микросхемах 
L6390 и L6392 однотипная – сигналы 
HIN, LIN и SD.

Отличие микросхемы L6393 от L6390 
и L6392 заключается не только в отсут-
ствии операционного усилителя. Компа-
ратор в L6393 независим от остальных 
элементов схемы и, в принципе, может 
быть использован в произвольных це-
лях. Однако наиболее разумное приме-
нение – контроль тока и формирование 
признака превышения (по аналогии с 
выводом DIAG в микросхеме L6386E, 
рассмотренной выше). Основное отли-
чие заключается в логике управления – 
комбинация управляющих сигналов 
PHASE, BRAKE и SD является доста-
точно редкой (если не уникальной) для 
микросхем данного класса. Циклограм-
ма управления представлена на рис. 5.

Циклограмма ориентирована на 
управление непосредственно от сигна-
лов двигателя, например, постоянного 
тока и реализует т.н. механизм отло-
женного останова. Предположим, что 
BRAKE – это сигнал на исполнитель-
ный механизм, т.е. его низкий уровень 
включает двигатель независимо от со-

стояния сигнала PHASE. Опять же 
предположим, что PHASE – это сиг-
нал с датчика обратной связи, напри-
мер, с частотного датчика, установлен-
ного на валу двигателя, или концевого 
датчика, обозначающего точку оста-
нова. Тогда высокий уровень сигнала 
BRAKE остановит двигатель не немед-
ленно, а только по положительному пе-
репаду сигнала PHASE. Скажем, если 
речь идет о приводе каретки, то сигнал 
останова (высокий уровень BRAKE) 
может быть подан заблаговременно, 
но останов произойдет только в кон-
кретной точке (при срабатывании дат-
чика PHASE).

На рис. 6 показана структура и схе-
ма включения микросхемы L6393.

О параметрах. Значения выходных 
токов IO+ (IO-), равные 270/430 мА, 
уступают микросхемам компании 
International Rectifier (у которых, как 
отмечалось выше, типичными являются 
290/600 мА). Тем не менее, динамиче-
ские параметры TON/TOFF (125/125 нс) 
превосходят (и часто существенно) все 
микросхемы семейства IRS.

Выводы по семейству L639x. При 
достаточно высоких количественных 
характеристиках, что само по себе по-

зволяет отнести семейство L639x к 
группе лидеров отрасли, дополнитель-
ные функции придают качественный 
скачок, поскольку позволяют реализо-
вать в одной микросхеме те функции, 
которые ранее реализовывались с ис-
пользованием ряда дополнительных 
компонентов.

Заключение
Безусловно, номенклатуру вы-

соковольтных драйверов компании 
STMicroelectronics нельзя признать 
очень широкой (хотя бы в сравнении 
с аналогичными изделиями компании 
International Rectifier). Тем не менее, 
количественные и качественные харак-
теристики рассмотренных семейств не 
уступают лучшим изделиям IR.

Говоря о драйверах MOSFET- и 
IGBT-транзисторов, нельзя не упомя-
нуть и сами транзисторы; компания 
STMicroelectronics выпускает достаточ-
но широкую линейку полевых (напри-
мер MDMESH V и SuperMesh3) и бипо-
лярных транзисторов с изолированным 
затвором. Поскольку эти электронные 
компоненты совсем недавно освеща-
лись в данном журнале [2, 3, 4], то они 
оставлены за рамками данной статьи.

Рис. 5. Циклограмма управления логики PHASE/BRAKE/SD

Рис. 6. Структура и схема включения L6393
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И наконец, как упоминалось 
выше, линейка драйверов MOSFET- 
и IGBT-транзисторов компании 
STMicroelectronics не исчерпывает-
ся драйверами полумостовой схемы. 
С номенклатурой драйверов категорий 
«Single» и «Multiple» и их параметрами 
можно ознакомиться на официальном 
сайте компании STMicroelectronics – 
www.st.com.
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MDMEDH V в корпусе PowerFlat

STMicroelectronics, мировой лидер 
в области силовых МОП транзисто-
ров, разработала для транзисторов 
семейства MDMESH V новый кор-
пус PowerFlat с улучшенными ха-
рактеристиками, специально пред-
назначенный для поверхностного 
монтажа. Размеры корпуса 8х8 мм 
при высоте 1 мм (PowerFlat 8x8 HV). 
Его малая высота позволяет созда-
вать более тонкие блоки питания, 
а также – снизить размер печат-

ной платы или увеличить плотность 
монтажа. Контактом стока в корпу-
се PowerFlat является большая от-
крытая металлическая поверхность, 
которая способствует улучшению 
теплоотвода и, соответственно, по-
вышению надежности. Данный кор-
пус способен работать в диапазоне 
температур -55...150°C.
Транзисторы семейства MDMESH 
V – это лучшие транзисторы в мире 
с точки зрения сопротивления от-
крытого канала в области рабочих 
напряжений 500...650 В. Например, 
транзисторы серии STW77N65M5 из 
семейства MDMESH V имеют для 
рабочего напряжения 650 В макси-
мальное значение Rdson на уровне 
0,033 Ом и максимальный статиче-
ский ток 69 А. При этом заряд затвора 
такого транзистора составляет всего 
200 нК. STL21N65M5 – это первый 
транзистор из семейства MDMESH 
V в корпусе PowerFlat. При рабо-
чем напряжении 650 В транзистор 
STL21N65M5 имеет сопротивление 
открытого канала на уровне 0,190 Ом 
и максимальный статический ток на 
уровне 17 А, при этом заряд его за-
твора составляет 50 нК.

Утром 5 апреля в редакцию жур-
нала пришла печальная весть. Нака-
нуне скоропостижно скончался один 
из старейших сотрудников компании 
КОМПЭЛ, член редколлегии жур-
нала «Новости электроники» Алек-
сандр Райхман.

Ему недавно исполнилось 60, но 
все коллеги звали его просто Сашей. 
В этом не было никакой фамильярно-
сти, а была особая теплота и любовь, 
которую испытывали к нему все, кто 
его знал. В Саше была та особая спо-
койная мудрость, которая заставляла 
прибегать к его опыту во всех спор-
ных и запутанных ситуациях. Он был 
своего рода третейским судьей. 

Александр Райхман пришел ра-
ботать в КОМПЭЛ с одной из мо-

сковских «фирм», разрабатывавшей 
и внедрявшей электронику для под-
водного флота России. Многие из 
нас помнят его увлекательные рас-
сказы о поездках на Дальний Восток 
на испытания оборудования, о мор-
ских походах. А в компании КОМ-
ПЭЛ ему пришлось первым освоить 
работу с зарубежными производи-
телями электронных компонентов, 
принимать участие в заключении 
первых дистрибьюторских контрак-
тов, в том числе – самого первого, 
с компанией Burr-Brown, в дальней-
шем приведшего к многолетнему и 
успешному сотрудничеству с Texas 
Instruments. Но контракт заключить 
мало – нужно продвигать продук-
цию на российском рынке. И Саша 

начал писать и публиковать статьи 
о продукции, которую КОМПЭЛ 
продавал в России. В этом он так-
же был пионером, а стиль его изло-
жения остается непревзойденным до 
сих пор: Райхман был прирожден-
ным техническим писателем, умев-
шим понятно и просто рассказать о 
самых сложных вещах.

В последнее время Александр Райх-
ман координировал в компании работу 
с продукцией STMicroelectronics и не-
мало сделал для популяризации сре-
ди разработчиков электроники компо-
нентов ST. Номер журнала, который 
лежит перед вами, мы начинали гото-
вить вместе с ним. Редакция и редкол-
легия посвящают его памяти Алексан-
дра Райхмана. Нашего Саши…

ПамЯти алекСандра райХмана
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